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SUMMARY  

The Ecological Intelligence for Reef Restoration and Adaptation Program (EcoRRAP) team at the 

Australian Institute of Marine Science (AIMS) quantifies natural rates of ecological and genetic reef 

recovery and adaptation in response to acute and chronic disturbances, as well as key environmental 

variables related to different coral reef communities.  This information is used to inform the Reef 

Restoration and Adaptation Program (RRAP) restoration interventions, the largest reef restoration 

program in the world as of 2020. The RRAP is a collaboration across many research institutes and 

experts, managed by AIMS.  

This document is the Standard Operational Procedure Volume 2, produced by the EcoRRAP sub-

program at the Australian Institute of Marine Science.  It details photogrammetry standard procedures 

for collecting images to reconstruct three-dimensional (3D) models and two-dimensional (2D) 

orthomosaics to quantify benthic communities over time (the fourth dimension, ‘4D’). The 

reconstructions created by this workflow exhibit sub-mm resolution, span extents of 75 - 1500 square 

meters, and use high-precision temporal co-registration techniques (Lechene et al. 2024). 

An introduction to the aims, theoretical background, and sampling design of EcoRRAP is provided in 

the first SOP of this series (SOP 1, Table 1). Details for other surveying methods used by EcoRRAP, 

including image processing during fieldtrips can be found in a series of Standard Operational 

Procedures described in Table 1 and are published online at: AIMS’s SOP page (Reef monitoring 

sampling methods | AIMS), EcoRRAP Metadata records (EcoRRAP Metadata), and the EcoRRAP 

Website (EcoRRAP (gbrrestoration.org). 

 

 

Table 1. EcoRRAP 3D photogrammetry tasks and associated standard operating procedures (SOPs). 

Task  Associated SOP  

Overview and in-field workflow Field photogrammetry in 4D: No. 1 of series  

Model processing Field photogrammetry in 4D: No. 2 of series (current doc.) 

Digitisation and metric extraction Field photogrammetry in 4D: No. 3 of series 

 

 

Information regarding data generated by the EcoRRAP program can be accessed through the 
Australian Institute of Marine Science’s metadata records (EcoRRAP Metadata). Additional links to 
project outputs can be found throughout this document. The EcoRRAP Database (internal document) 
and data management files and folder templates:  EcoRRAP Data Management Templates. Processing 
scripts are located on the EcoRRAP GitHub:  GitHub AIMS/EcoRRAP.  

 

 

 

 

https://gbrrestoration.org/the-program/
https://www.aims.gov.au/research-topics/monitoring-and-discovery/monitoring-great-barrier-reef/reef-monitoring-sampling-methods#SOPreefmonitoring
https://www.aims.gov.au/research-topics/monitoring-and-discovery/monitoring-great-barrier-reef/reef-monitoring-sampling-methods#SOPreefmonitoring
https://apps.aims.gov.au/metadata/view/fe9659f1-12d6-4acf-ab89-67acdd37efe5
https://gbrrestoration.org/program/ecorrap/
https://www.aims.gov.au/sites/default/files/2023-08/AIMS_EcoRRAP_SOP14_V1_FIeld-Photogrammetry4D_Overview-infield-workflow_2023.pdf
https://apps.aims.gov.au/metadata/view/fe9659f1-12d6-4acf-ab89-67acdd37efe5
http://corporate.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
https://github.com/open-AIMS/EcoRRAP
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1 INTRODUCTION 

1.1 Overview 

Note: A detailed overview of the EcoRRAP subprogram, sampling design, and image collection 

techniques used are provided in the first SOP of this series “SOP 1: Overview and in-field workflow” 

(Gordon et al. 2023). 

The Reef Restoration and Adaptation Program (RRAP) brings together leading experts from Australia 

and around the world to help protect the future of the Great Barrier Reef, other Australian reefs, and 

coral reefs globally. The ‘EcoRRAP’ subprogram aims to maximise the success of restoration 

interventions by advising on the ‘what’, ‘where’, and ‘when’ of interventions, and by filling crucial gaps 

in ecological knowledge of the Great Barrier Reef (GBR)(EcoRRAP). 

EcoRRAP uses close-range photogrammetry to quantify structural complexity, benthic communities, 

and demographic rates of coral reefs across spatial and temporal scales. Two key outputs are created 

from the images collected by EcoRRAP: (1) 3D digital surface models (DSMs), used to quantify 

landscape metrics, and: (2) 2D orthomosaics, used to quantify benthic community composition and 

demographic rates of corals of several taxa and morphologies. All photogrammetry outputs are 

generated using Structure from Motion (SfM) algorithms (Ferrari et al. 2016, Aston et al. 2022, Aston 

et al. 2023) which locate and track correspondence between images and use these trajectories to 

reconstruct their location in 3D space and thereby create representations of reef topography.  The 

incorporation of model co-registration techniques further enables changes in 2D and 3D outputs to 

be precisely examined to describe changes in landscape metrics and community compositions, and to 

quantify demographic rates of benthic taxa with mean precision of 1.37 mm (Lechene et al. 2024). 

 

1.2 How to use this Standard Operational Procedure (SOP) 

The EcoRRAP photogrammetry workflow consists of three key stages, here presented in three SOPs 

(Fig. 1, Table 1): 1) Field-based data collection and model building; 2) Office-based model building 

using HPC systems, and; 3) Model annotation and metric extraction. The workflow described in this 

SOP begins once imagery has been collected, downloaded, Metashape projects have been created, 

and field processing for QCQA have been completed (described in SOP 1). An essential component of 

this time-series workflow is the process of aligning models from different time-points, or epochs, to 

the same 3D coordinate space and orientation, a process called ‘co-registration’ (Figs. 1,2; Lechene et 

al. 2024). 

‘Co-registration’ uses one model as the ‘reference’ (i.e. T1) to which other subsequent model time-

points (e.g. T2, T3) are spatially aligned (Fig. 2). The orientation of the ‘reference’ model is specified 

using a series of steps (see section 3.3.1, Table 9) before ‘reference’ outputs are generated (e.g. 2D 

orthomosaics and 3D DSMs, Fig. 2). For subsequent time-points, co-registration with the reference 

model is required before outputs are generated (Fig. 2). This step is essential to ensure models are 

precisely aligned in 3D-space to allow accurate and precise quantification of change over time of 

different spatial metrics (e.g. colony growth or rugosity changes). 

As for SOP 1, some aspects of this manual are specific to the equipment and aims of this program, 

however the document also presents useful information for a wide range of photogrammetry users. 

https://www.aims.gov.au/sites/default/files/2023-08/AIMS_EcoRRAP_SOP14_V1_FIeld-Photogrammetry4D_Overview-infield-workflow_2023.pdf
https://gbrrestoration.org/program/ecorrap/
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The final stage of the EcoRRAP photogrammetry workflow, model annotation and metric extraction, 

is covered for 3D DSM complexity metrics in the current document (see section 3.7.1) and for 2D 

orthomosaics in SOP 3 ‘Digitisation and metric extraction’ (Figs, 1,3, Table 1). Metric extraction is 

described in SOP 2 and 3, as steps in SOP 3 are significantly more involved and may only be of interest 

to a specific audience. In contrast, deriving 3D structural complexity metrics from photogrammetric 

outputs is more general in application. 

At the time of writing, Agisoft Metashape v.1.7.6 is in use and instructions are reflective of this. Future 

versions of Metashape will likely require updating of python scripts and revision towards more 

efficient workflows. Reviews of this SOP will be conducted during the life of the sub-program as 

required (see disclaimer page). Procedures that are regularly updated, and/or are AIMS-specific, are 

described in the AIMS 3D Modelling Onenote (internal link). See this link for AIMS-specific IT 

considerations (AIMS server access, VPN, etc). If you are using your own network you will need to 

ensure correct setup is complete before following the steps in this SOP. 

 

Figure 1. EcoRRAP photogrammetry workflow, related SOPs, and key data outputs.  

Image: S. Gordon, reproduced from SOP 1. 

 

 

 

 

 

 

 

 

Figure 2. Co-registration workflow considerations for ‘reference’ (T1) and subsequent (‘non-

reference’, T2, T3…) models. Note that if only one time-point is measured (T1), model orientation is set 

but co-registration is not required before generating outputs (2D orthomosaics and 3D digital surface 

models). When multiple time-points are measured, co-registration is an essential step required prior 

to generating outputs (see red arrows). Image: S. Gordon. 

 

https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
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Figure 3. Three- and two-dimensional representations of the reef topography at an EcoRRAP plot 

produced using Structure from Motion (SfM) techniques: (A) a 3D digital surface model (DSM), and; 

(B) a 2D orthomosaic. Image: S. Gordon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3. Three- and two-dimensional representations of the reef topography at an EcoRRAP plot 

produced using Structure from Motion (SfM) techniques: a) a 3D digital surface model (DSM), and; b) 

a 2D orthomosaic. Image: S. Gordon, reproduced from SOP 1. 
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2 HARDWEAR AND SOFTWARE  

2.1 Hardware  

The current EcoRRAP 3D-processing workflow represents a variety of trade-offs between output 

quality and processing efficiency. All steps and settings recommended are the result of rigorous testing 

and are strongly influenced by available computing capacity. All processing steps were designed to be 

completed locally on consumer-grade desktop computers or high-powered laptops. While all 

processing can be completed locally on desktops or laptops, the use of high-powered computing (HPC) 

nodes increases processing efficiency significantly and is therefore recommended if available 

(particularly for ‘office-based steps’, Table 2). Specifications for computers and HPC nodes used in the 

current workflow are described in Table 2. Computers with lower specifications than Table 2 may also 

be able to follow the described workflow, however alterations may be needed to make this feasible 

(e.g. decreasing the number of photos used or the quality settings selected).   

Table 2. Computing specifications used for model processing with the current workflow. 

Specification ‘In-field’ processing ‘Office-based’ processing  
Processing location Local Network Network 

Computer type Laptop HPC CPU node HPC GPU node 

Model Dell Latitude (7780) NA (as below) NA (as below) 

Processor (CPU) Intel Core i9 
16 Core, 32 threads 

64 GB RAM, 36 MB cache 
5.5 GHz, 55 W 

AMD EPYC 7643 
48 core, 96 threads 

512 GB RAM, 256 MB Cache 
2.3 GHz, 225 W 

Intel Xeon w5-3435X 
16 core, 32 threads 

128 GB RAM, 45 MB cache 
4.7 GHz, 270 W 

Video card (GPU) NVIDIA RTX A4500 
20 GB G DDR6 

NA Quad (x4) NVIDIA RTX A4500 
20 GB G DDR6 

Hard drive / storage 4TB SSD NA – Network storage NA – Network storage 

 

 

2.2 Software and applications  

All software applications used in the EcoRRAP 3D-processing workflow and their purpose is listed in 

Table 3. ‘Agisoft Metashape Professional’ is the primary software used for 3D model processing, while 

addition software is used for model co-registration and output manipulation. Updated download 

sources and manuals for applications listed in Table 3 are available in section 4.2 and internally here. 

 

Table 3. Software and applications used in EcoRRAP 3D-processing workflow. Software marked with 

an Asterix(*) require a paid licence. 

 

Provider Software Use in workflow 

Agisoft Metashape Professional* Build 3D models from images, produce 3D digital 
surface models (DSMs) and 2D orthomosaics 

Agisoft Network monitor* Monitor progress of jobs sent for network processing 
CloudCompare CloudCompare Co-register and compare DSMs between years 
Python Python Write/edit code to automate processing in Metashape 
ESRI ArcGIS Pro* Check and clip 2D orthomosaics prior to annotation 

https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
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2.3 Model processing scripts, ‘chains,’ locations, and logs  

The current processing workflow minimizes user input while ensuring high-quality, standardised 

outputs though a combination of semi-automated scripts and manual quality checks. The EcoRRAP 

model processing pipeline uses three main processing ‘chains,’ each consisting of multiple functions, 

and the use of additional single-task scripts (Table 4). All scripts are designed to be run within 

Metashape (e.g. using ‘CRTL+R’ shortcut), however can be adapted for use without launching 

Metashape (i.e. python-only workflows). User input and quality checks are generally required before 

and after running each chain, but no manual input is required while each chain is running.  

Note: Before running any chain for the first time, it is important to open the script (in any text viewer 

or script editing software) and read the summary of steps involved and any user input required.  

Metashape model processing steps, or ‘jobs,’ can be run ‘locally’ (directly on a computer) or via 

‘network processing’ (sent to a group of networked computers, servers, and/or HPC nodes). The 

recommended processing location for each job is dependent on the stage of processing, task duration, 

and computing power requirements. All initial ‘in-field’ processing steps are designed to be run locally 

on laptop computers (Tables 2,4) as internet-based network processing is generally limited in the field 

(however network-adapted versions of ‘in-field’ chains are also provided). Many ‘in-office’ processing 

steps have greater computing requirements and are therefore largely network-processed using 

networked computers or HPC nodes if available (Table 2,4). Most small/single jobs, such as exporting 

outputs, are also generally best run locally.  

All scripts required for the current workflow are available in the AIMS EcoRRAP GitHub: GitHub 
AIMS/EcoRRAP3D. Scripts are provided for both DSLR and GoPro processing pipelines and in local and 
network processing formats. See section 1.2 for more information regarding script versioning and 
updates. The software ‘Agisoft Network Monitor’ is used to monitor the progress of Metashape jobs 
run via network processing. Agisoft Network Monitor logs and estimates processing time, reports 
errors, and allows jobs to be paused, aborted, and ranked in order of priority (Agisoft Metashape: User 
Manuals, Table 3). Information about Metashape network set-up and management is provided in the 
relevant Agisoft Metashape user manual: Agisoft Metashape: User Manuals. 

Throughout model processing, progress and metadata are recorded in the EcoRRAP Access Database 

and EcoRRAP Processing Log (EcoRRAP Data Management Templates). Key scripts and logs used for 

EcoRRAP model processing are described in Table 5. Where differences in DSLR and GoPro processing 

occur it is noted throughout this document.  

 

 

https://github.com/open-AIMS/EcoRRAP3D
https://github.com/open-AIMS/EcoRRAP3D
https://www.agisoft.com/downloads/user-manuals/
https://www.agisoft.com/downloads/user-manuals/
https://www.agisoft.com/downloads/user-manuals/
http://corporate.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
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Table 4. Summary of python chains and scripts used in the EcoRRAP 3D processing workflow. Note that script applications and order of use differ between 

‘reference’ models (T1) and subsequent time-points (T2, T3…)(see Fig. 2). All script files are named with the suffixes ‘Local’ or ‘Network, and ‘DSLR’ or ‘GoPro’ 

to differentiate between processing locations and cameras (e.g. ‘Chain1_Local_DSLR.py’), steps that differ between DSLR and GoPro processing are marked 

with an Asterix(*).  

Model Order File name (.py) Application  Recommended 
processing location  

Reference (T1) 1 Chain1 In-field processing steps Local 
 2  Chain2.1 In-office processing steps part 1 Network  
 3 PS170_geobit_helper (AccuPixel 2021) Launch function to orient reference model Local 
 4 Chain2.2 In-office processing steps part 2 Network  

 
Subsequent 
timepoints (T2,..) 

1 Chain1 In-field processing steps Local 
2 Chain2 In office-processing steps Network  
3 Chain3  Apply co-registration, apply reference bounding-box* Local 

 

Table 5. Summary of files used in EcoRRAP 3D processing workflow and associated access locations. 

File name File  Description File location 

Multiple (see Table 4) .py Python scripts used to run a Metashape processing steps GitHub AIMS/EcoRRAP3D 
EcoRRAP_Database .db EcoRRAP Access Database used for metadata, sampling event information, and 

marker data entry (AIMS internal access only) 
EcoRRAP Data 
Management Templates 

EcoRRAP_Processing Log .xlx Log file used to record model statistics, processing progress, and model QA/QC 
Multiple (see Table 1) .pdf SOPs used to inform and standardise processing (e.g. current document) Reef monitoring sampling 

methods | AIMS) 

https://github.com/open-AIMS/EcoRRAP3D
http://corporate.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://corporate.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
https://www.aims.gov.au/research-topics/monitoring-and-discovery/monitoring-great-barrier-reef/reef-monitoring-sampling-methods#SOPreefmonitoring
https://www.aims.gov.au/research-topics/monitoring-and-discovery/monitoring-great-barrier-reef/reef-monitoring-sampling-methods#SOPreefmonitoring
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3 WORKFLOW  

3.1 Summary 

The current section summarises the main stages in the EcoRRAP 3D model processing workflow (Fig. 

1 and Table 6, Appendix 1), from photo input to the export of 2D and 3D products. Each step is 

explained in detail in subsequent sections. While most processing steps are similar for camera types 

and ‘reference’ (i.e. T1) and subsequent models (i.e. T2, T3, etc.) there are a few important 

considerations and exceptions described in section 3.2. 

 

Table 6. Overview of EcoRRAP 3D model processing workflow. All steps are described in more detail 

in Tables 7-12, also available in Appendix 1. 

Step Platform Key tasks  

Model processing  
(in-field) 

File management 

Microsoft Access 

 

Agisoft 
Metashape 

 

•  Copy image files to computer  

•  Enter metadata and marker depth data into database 

•  Export and save ‘Marker depth’ CSVs from database 

•  Create Metashape project file and import photos 

•  Run processing script: ‘Chain 1’ (Local processing) 

•  Conduct manual QA/QC checks  

Model processing 
(in-office) 

Agisoft 
Metashape 
 

•  Save photos and Metashape projects to network drive 

•  Open Agisoft Network monitor and prepare network 
processing 

•  Reference models (T1) 
- Run Chain 2.1 (Network processing if available) 
- Set reference model orientation (use associated script) 
- Run Chain 2.2 (Network processing if available) 

•  Subsequent timepoints (T2, T3…) 
- Run Chain 2 (Network processing if available) 

•  Conduct manual QA/QC check 

•  Export 3D models 

  CloudCompare 
 
 
 

Agisoft 
Metashape 

•  Load ‘reference’ and ‘test’ (subsequent timepoint) models  

•  Complete model co-registration and QA/QC 

•  Export transformation matrix 

• Subsequent timepoints (T2, T3…) 
- Load project and run ‘Chain 3’ (Local processing) 

Output 
generation 

Agisoft 
Metashape 
 
ArcGIS 
(DSLR only) 

•  Generate orthomosaic  

•  Export orthomosaic (.tif) as 2D output (final ref. 2D output) 

•  Export 3D model (.ply) as final 3D output (ref. and subs.) 

• Clip orthomosaics from subsequent timepoints (T2, T3…) to 
reference extent in ArcGIS and save final subs. 2D output  
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3.2 General processing considerations 

Before starting the EcoRRAP 3D model processing workflow it is important to take note of a few 

important considerations: 

• Some steps differ between ‘reference’ (i.e. T1) and subsequent models (i.e. T2, T3, etc.)(Fig. 2) 

• Some steps differ between DSLR and GoPro processing workflows 

• All files and folders are recommended to be saved as per file/folder naming structures specified 

• Progress throughout processing stages should be recorded in logs for on-going QA/QC (Table 5) 

• See SOP 1 for a description of the EcoRRAP sampling design and definitions of ‘Plots’ and ‘Zones’ 

In addition to this, a few key concepts that may influence processing design and planning are 

described below.  

 

3.2.1 Processing time and manual input considerations 

Model processing time can vary significantly depending on computing resources and may range from 

as little as 1-2 hours per job if multiple HPC nodes are available to >24 hours per job if processed 

locally. Similarly, although the current workflow is designed to minimise manual user input, depending 

on the number of sites and/or time-points measured this can multiply out to be a large workload (i.e. 

EcoRRAP has > 350 sites). Accordingly, efficient planning, management, and QA/QC is important and 

best achieved by progressing multiple (or all) projects through to the same processing stage before 

moving the next. For example, process all projects to the end of Chain 2 before starting co-registration, 

rather than processing one project all the way to completion. This also allows QA/QC to be completed 

more effectively, as model characteristics and statistics can be compared between projects and help 

detect potential issues. Tasks requiring the most significant manual user input in the workflow are: 

 

• Quality checks 

It is essential that quality checks are performed after each processing step is completed to ensure 

that any issues with reconstructions are resolved before processing is continued. This minimises 

down-stream issues (i.e. issues with reference models will affect all subsequent models) and the 

need to re-run processing steps. Some of the most important quality checks relate to model 

alignment:  

- If model alignment is <80 % and/or models do not look representative of the reef habitat 

mapped, processing cannot not be continued without troubleshooting 

- Issues with alignment cannot be resolved in subsequent steps and may indicate a fundamental 

problem (see Fig. 5, Troubleshooting in Appendix 5) 

 

• Reference model orientation 

Manual user input is required to orient the reference (i.e. T1) model, rotate (if required), and place 

the bounding box in the position of interest. Once set, the reference model orientation and extent 

will be applied to all future timepoints (models). Accordingly, all ‘reference only’ steps only need 

to be completed for one timepoint of each ‘plot’ (unique spatial area). 
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• Model co-registration 

Manual user input is required to identify and select common features (spheres and points) in 

models within the software (CloudCompare) to co-register models in 3D space. This step can 

require the largest amount of manual user input in the current workflow. The amount of manual 

input required to co-register one model can range from approx. 10-20 minutes per model (plus 

troubleshooting if there are issues with reference marker movement or reconstruction). 

 

• Troubleshooting 

One of the most time-consuming, but essential, manual tasks in the current workflow involves 

troubleshooting issues with individual models. These issues are generally caused by user error 

and/or issues with image collection (e.g. wrong camera settings or very low visibility conditions), 

file storage and management (e.g. files saved in wrong folder, co-registering wrong files), and 

processing mistakes (e.g. forgetting to complete a step or run a script before progressing). 

Additional troubleshooting can also be required if errors occur during model-building (e.g. low 

percentage alignment or abnormalities in model reconstruction shape). Troubleshooting tips for 

frequently encountered errors are provided in Appendix 5 and can best be avoided by careful, 

documented processing, and ongoing QA/QC throughout the workflow. 

 

3.2.2 DSLR and GoPro processing  

While many steps in the EcoRRAP model processing workflow are consistent for DSLR and GoPro 

imagery, it is important to note that there are a few key differences. Although it is not feasible to 

explain all differences here, general examples of these are:  

 

• Differences in settings 

Example 1: ‘Lowest-’ and ‘medium-’quality alignment is used for initial model processing of DSLRs 

and GoPro imagery, respectively. This reflects a trade-off between computing time requirements, 

and the quality and utility of resultant sparse clouds, e.g.: 

o DSLR models: ‘Lowest’ quality sparse clouds (4-8 hours local processing using a laptop and 

~2500  x 40 MP images) are sufficient to detect issues with alignment and are good predictors 

of ‘high’-quality alignment rate (i.e. models with ≥ 80 % alignment at lowest quality generally 

have ≥ 80 % alignment at ‘high’ quality).  

o GoPro models: ‘Lowest’ quality sparse clouds are poor indicators of GoPro model issues and 

predictors of ‘high’-quality alignment rate, therefore ‘medium’ quality alignment (6-10 hours 

local processing using a laptop and ~6000 x 20 MP images) is used.   

 

• Differences in processing steps and project structure 

Example 1: The bounding box (model extent) of reference models is automatically re-sized (to 12 

x 6 x 10 m in length, width, and height, respectively) for DSLR models but not GoPro models. This 

step standardizes DSLR model extent but is not suitable for larger GoPro models where shape and 

extent is not uniform and can vary significantly depending on reef structure and shape.  
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Example 2: DSLR ‘plots’ (72 sq. m areas) are imaged individually, saved, and processed individually 

as one plot per Metashape project. In contrast, GoPro ‘zones’ are imaged as one large area 

(containing all DSLR plots), saved as one Metashape project, and then are split into two halves 

(plots 1 &2, and plots 3 &4). These differences in workflow are designed to achieve multiple 

objectives: minimizing DSLR project size, improving script simplicity, maximising efficiency of in-

water DSLR and GoPro data collection, and improving quality of GoPro model co-registration. 

 

3.3 In-field model processing 

The following text (section 3.2 and referenced tables and images) is adapted from Section 3.5 of SOP 

1: Overview and in-field workflow (Gordon et al. 2023) and commences post-dive, once imaging has 

been completed. For more information and background on imagery collection see SOP 1.  

In-field data management and model processing involves the following general steps: 1) downloading 

and organising camera imagery; 2) entering metadata and ground control point (GPC) data; 3) 

conducting initial 3D processing steps (Chain 1), and; 4) backing-up files. All steps are designed to be 

conducted daily and are described in detail in Tables 6 and 7. The current workflow requires 

approximately 2-3 hours of work by 1-2 staff members following the completion of image collection 

for the day. Accordingly, this workflow can be altered (e.g. postponing 3D processing until after the 

completion of fieldwork) if required to suit specific time, personnel, or equipment limitations.  

Note: The EcoRRAP imaging workflow can result in the production of tens of thousands of images, 

associated metadata, and Metashape project files. Accordingly careful and methodical data 

management is essential to avoid data loss and errors. 

Post-dive workflow commences when divers have completed the ‘in-water workflow’ (SOP 1) and 

have washed down camera equipment (see SOP 1). Images from camera memory cards are then 

copied to a computer following the folder structure recommended in Table 7. While images are 

downloading, collected metadata and GPC measurements should be entered into their respective 

locations in the master access database file (Fig. 4, Table 7). At this time, Metashape projects can also 

be created, and imagery imported to create one project per ‘plot’ (72 sq. m area, DSLR imagery) and 

one project per ‘zone’ (~1500 sq. m area containing all four ‘plots’, GoPro imagery) using the file 

naming conventions described in Table 7. 

It is recommended to conduct the initial stages of 3D model processing in Metashape (described in 

Table 8) to assist with in-field QA/QC and to optimize post-field processing workflow. In-field 

processing steps are designed to help identify image collection errors (e.g. incorrect camera settings 

or swim pattern), data-management errors (e.g. incorrect file storage or file deletion) and identify if 

re-imaging of plots is required (Table 8). At the completion of each day all data should also be backed-

up to an appropriate number of internal and external drives using a back-up software (see steps in 

Table 7) to ensure data integrity prior to clearing camera memory cards.  

 

https://www.aims.gov.au/sites/default/files/2023-08/AIMS_EcoRRAP_SOP14_V1_FIeld-Photogrammetry4D_Overview-infield-workflow_2023.pdf
https://www.aims.gov.au/sites/default/files/2023-08/AIMS_EcoRRAP_SOP14_V1_FIeld-Photogrammetry4D_Overview-infield-workflow_2023.pdf
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Table 7. Post-imaging data management and pack down (reproduced from SOP 1 (Gordon et al. 2023), Table 1). 

Step Part/consideration Key tasks Additional info 

Download 
DSLRs and 
GoPros 

Rinse camera 
housing  

• Remove cameras from camera rig mounts 

• Rinse cameras in housings in freshwater 

• Turn cameras off and press all buttons and levers in freshwater 

• Press buttons and levers again once out of water 

• Allow housings to dry 

• Purge housing pressure and replace cap (for DSLRs) then open housings 

• Check housings for water intrusion, wipe dry, and re-close to keep clean 

Video of some DSLR steps: 
https://vimeo.com/246180473 
 

 Remove camera 
and SD card 

• Remove cameras from housing 

• Remove SD cards and prepare to copy data to computer (SSD fastest) 

• Remove camera batteries and charge 

Note: Maintaining consistency 
in data management and 
collection protocols, e.g. which 
cameras each diver uses and 
which plot they image, 
significantly assists clarity and 
ease in file management 
(especially after a long day of 
diving) 
 

 
 

Prepare and copy 
to standard file 
structure 

• Ensure ‘data’ folder naming structure is correct 

Folder structure: EcoRRAP\data\DATE\REEF\SITE\ZONE\PLOT 

• Copy photos into respective plot folder 

• Images from DSLRs are named relative to the camera (e.g EC1…) and will be 

automatically saved into SD card folders when imaging is stopped and started  

• Images from GoPros are not automatically named by camera or sorted into 

folders by imaging period. Accordingly, care should be taken to check capture 

time, rename downloaded files (e.g. GP1…) and keep track of SD card 

numbers to help with clarity during downloading 

Database  
 

Enter sample 
event information 
(Fig. 4a) 

• Open EcoRRAP Access Database 

• Navigate to the form ‘FrmDataEntry’ > ‘Reef’ tab and alter any changes to 

reef clusters, reefs, sites, zones, GPS locations and picket numbers 

• Navigate to the form ‘FrmDataEntry’ > ‘Sample’ tab and select the reef, site, 

zone, and plot information from the drop-down menu related to the data to 

be entered 

• Fill in all information required for the sample in a new row 

EcoRRAP Access Database 
(internal document):  EcoRRAP 
Photogrammetry Data 
Management Templates - 
AIMS 
 

https://vimeo.com/246180473
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
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 Enter marker data 
(Fig. 4b) 

• Navigate to the form ‘FrmDataEntry’ > ‘Markers’ tab and select the reef, 

site, zone, plot, and sample information from the drop-down menu related 

to the data to be entered 

• Enter marker depth information (one depth per row) ensuring to complete 

all drop-down categories 

Triad names 

• ‘Small’ triads = ‘Triad100’ 

• ‘Large’ triads =’Triad150’ 
 
 
 

 Export marker 
depth CSV 
(Fig. 4c,d) 

• Navigate to the ‘target_depth_all’ query  

• Filter the first two columns for the plots and sample required 

• Select cells to be copied (all columns from columns ‘target’ to ‘z-error’), the 

right click and select ‘copy’  

• Paste cells into an excel file and delete row heading 

• Save file as a CSV named as per file naming convention:  

REEF_SITEZONE_PLOT_YEARMONTH 

e.g. OCDA_FR1S_P1_202401 

NOTE: For general users not using the EcoRRAP database, ensure metadata 

is entered in your desired format and save depth/coordinate information in 

the same format as the ‘Depth csv template file’ for input into Metashape 

(see example selected cells in Fig. 4d) 

Depth csv template: EcoRRAP 
Data Management Templates 
 
Scaling coordinates and error 
details in Appendices 2,3,4 

Agisoft 
Metashape 
processing 

Create Metashape 
project file 

• Create new Metshape project file (one file per DSLR ‘plot’ or GoPro ‘zone’)  

• Save project with the following naming convention in the following folder 
structure:  
DLSR project: ‘REEF_SITEZONE_PLOTNUMBER_DATE.psx’  
GoPro project: ‘REEF_SITEZONE_DATE_GoPro.psx’  
Folder structure: EcoRRAP\projects\REEF\SITE\ZONE\DATE 

 

Note: Folder structure for data 
and projects is slightly 
different (note location of 
‘date’ folder in each). This is to 
allow easy coping of all data to 
a central location on return 
from the field.  Take care 
when creating folders to 
ensure consistent paths. 

 Import photos into 
project 

• Import all plot photos into project by dragging and dropping the folder 
containing plot photos into the ’Photos’ pane of Metashape 
 

http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
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 Start initial 
processing 

• Run processing script: ‘Chain 1’ and follow script prompts 
- Use the ‘local’ version of the script if processing locally on a single 

computer (most common when in field) or the ‘network’ version if jobs 
are being sent to a group of networked computers, servers, and/or HPC 
nodes (most common when in office) 

• If first time using script, navigate to script and right click to open in IDLE or 
alternative viewer and read initial script lines to understand functionality, 
required user inputs, and default values used 

• Confirm default settings and file paths within the script are correct  

• In Metashape, navigate to Tools > Run Script (or Ctrl + R) to run script 

• When prompted, click the Browse button (folder icon) and navigate to and 
select the version of ‘Chain 1’ required  

• Click ‘no’ to network processing (if prompted) 

• A pop-up will then prompt you to locate the folder containing the target 
depth CSV file for the project (exported in previous steps) 

• The script will automatically begin processing (run time 4-8 hours) and will 
complete the jobs listed in Table 8 
 

Note: While script is running, 
monitor progress and 
computer performance 
through the dialogue box in 
Metashape and through 
Windows Task Manager (CPU, 
GPU, and memory usage). 
Chain 1 can be run locally on 
approx. 3-4 x DSLR, or 2 x 
GoPro projects simultaneously 
on computers with 
specifications as per Table 2 
  

Back up 
files 

Create copies of 
files with 
GoodSync  
(or alternative 
back-up software) 

• Once photos are downloaded from SD cards to a computer SSD, a back-up 

should be run from the computer to an external drive  

• An additional copy may also be sent to copy overnight to ensure there are a 

minimum of 2-3 copies of the data before SD cards are formatted the 

following morning (or swapped if more available) 

• Backups of metadata and Metashape projects should be completed daily  

• If files are deleted from the local computer drive (i.e. space runs out) ensure 

to un-check any files that GoodSync (or other back-up software) identifies 

as ‘files to be deleted’ by clicking the little circle next to the ‘do not copy’ 

text 

• Ensure there are no listings in the ‘files to be deleted’ tab before proceeding 

with the sync 

 

GoodSync manual:  GoodSync 
Tutorial 
 
Note: Coordination of file 
backups is generally best 
completed by one person to 
minimise errors due to 
miscommunication. Use of 
back-up software is very 
helpful but can propagate 
deletions throughout copies so 
use with care! 

https://www.goodsync.com/tutorial
https://www.goodsync.com/tutorial
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Table 8. Metashape processing steps involved in processing Chain 1 (reproduced from SOP 1 (Gordon et al. 2023), Table 1). 

Job name  Job description  Settings used for DSLR and GoPro 
(bolded if GoPro differs) 

Quality check  • Assesses the quality of photos and removes photos below the quality 
threshold 

• Disables, counts, and adjusts (if required) the quality threshold to retain 
the targeted number of photos 

• Begins using a quality threshold of 0.5 and reduces this value (if required) 
by 0.05 until the target minimum number of photos is reached or the 
minimum quality threshold is reached (0.35) 

• The quality threshold and number of photos prior to and after disabling is 
logged  

• Target number of photos (to retain): 
- 2000 for 1 x DSLR ‘plot’,  
- 2000 for 1 x GoPro ‘zone’ (4 x DSLR plots 

• Initial quality: 0.50  

• Minimum quality: 0.35  

• Quality step value: 0.05  

• Note: GoPro images with a quality value of ‘0.0’ can be 
used for analysis if the target number of photos is not 
reached and a visual assessment of image quality is OK  

Initial alignment    • Aligns photos to create a sparse-cloud of pixel positions in 3D space  

• See Appendix 5 for troubleshooting workflow if ‘minimum alignment’ is 
not achieved   

• Accuracy: Lowest, Medium  

• Generic preselection: Yes  

• Reference preselection: Source  

• Key point limit: 40,000  

• Tie point limit: 10,000  

QA/QC 
check and 
log  

Record processing 
progress in log 

• Once Chain 1 processing is complete, check for issues/errors 

• Fill in the ‘Process log’ of with results of Chain 1 

• Perform a check of photos and model to ensure:  

- Camera settings are correct and photos are good quality (Fig. 5) 

- A sufficient number of photos are enabled (see Table 8) 

- Alignment is > 80 % of enabled photos 

- Sparse cloud shape is a realistic and representative of area imaged 

- The minimum number and error of markers is achieved (see Table 8) 

- The minimum number and error of scalebars is achieved (see Table 8) 

• If the above requirements are not achieved conduct troubleshooting 

(Appendix 5) and determine whether plots require re-imaging 

Process log:  EcoRRAP Data 
Management Templates 
 

http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
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• Exclude stationary tie points: Yes  

• Guided image matching: No  

• Adaptive camera model fitting: No  

• Reset alignment: Yes  

• Minimum alignment: 80 %  
  

Detect markers  • Detects markers using ‘initial tolerance’ threshold and:  
- Removes marker projections with ≥ ‘marker projection error’ pixel 

threshold,  
- Disables markers with projection numbers < ‘minimum marker 

projections’ threshold  

  

• Target type: Circular Target 12 bit  

• Initial marker tolerance: 25 (85) 

• Secondary marker tolerance: 50 (95)  

• Marker projection error: 50 (150) 

• Minimum marker projections: 5 (10) 

• Filter mask: False  

• Inverted: True  

• No parity: False  

• Maximum residual: 5  

• Minimum size: 0  

• Minimum distance: 5  

Import depths   

 

• Imports marker X and Y coordinates, depth values (Z), and related 
accuracies into reference pane (CSV file saved in previous step, Table 
7) 

• See Appendix 2 for marker accuracy values  
 

 

Add and check scale 
bars    

• Adds scale bars based on marker number pairing and distances 
specified 

• Checks the number of scale bars is ≥ the ‘minimum scalebars’ 
threshold,  
if < threshold:  

• Marker are re-detected at ‘secondary marker tolerance’   
• Projection error tests are rerun  
• Scale bars are re-added  

• Calculates the overall scalebar error  
• Checks overall scalebar error is < the ‘maximum scale bar error’  

• Minimum scalebars: 3 (7) 

• Maximum scalebar error (m): 0.01 (0.02) 

• Scaling coordinates and error details in Appendices 
2,3,4 
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Warnings • If alignment is ≤ 80 % (‘minimum alignment’ threshold) 

• If scale bar error is > the ‘maximum scale bar error’  
 

Generate log and 
save project file  

• Automatically generates a processing log and deposits processing 
information in file 

  



   
 

11 
 

4  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4. EcoRRAP database steps for: a) entering sample information; b) entering marker depth data; 

c) filtering marker depth information, and; d) extracting marker depth information to save as a CSV 

file for later import into Metashape (described in Table 7). Image: S. Gordon (reproduced from SOP 1 

(Gordon et al. 2024), Table 1). 
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4.1 In-office model processing 

‘In-office’ processing commences after all ‘in-field’ model processing steps are complete and users 

have access to network storage and/or increased computing power. If these resources are not 

available all steps can be completed on a local device, however processing time will be significantly 

longer. Furthermore, depending on the outputs required and intended applications, certain steps may 

be omitted (e.g. if orthomosaics are not needed then ArcGIS steps are not required). The current in-

office processing steps are designed to create outputs ready and suitable for analyses and metric 

extraction described in SOP 3 (Table 1) and Section 3.7.  All steps are described in Tables 9 and 10 and 

Figures 1-3. See Appendix 5 for troubleshooting information.  

Note: Keep in mind the general processing considerations outlined in section 3.2 during in-office 

model processing. 

 

4.2 Model co-registration 

Model co-registration takes place following the completion of model processing Chains 1 and 2, after 

setting the orientation of ‘reference’ models, and exporting all textured meshes. Model co-

registration involves: 1) importing ‘reference’ (T1) and ‘test’ (subsequent timepoint, T2…) models into 

the software CloudCompare; 2) co-registering models in 3D space; 3) exporting and saving the 

coordinate transformation matrix as a text file (.txt), and; 4) applying this transformation matrix to the 

‘test’ project in Metashape to apply the model orientation in coordinate space. These steps are 

described in detail in Table 11 and Figs. 10 and 11. 

Because co-registration can be relatively time consuming (10-20 minutes per model) It is important to 

take care when loading, saving, exporting, and applying files to avoid errors in model co-registration 

and output orientation (section 3.5).  

Model co-registration is essential to ensure models of all time-points from the same reef area are 

positioned in the same 3D coordinate space. This enables changes to be directly compared over time 

accurately and effectively, e.g. growth of individual corals can be measured and tracked in 2D 

orthomosaics or 3D models (see SOP 3, Table 1). The co-registration method presented achieves a 

precision of 1.37 ± 16.55 mm (change < 0.0001%) for DSLR models across an extent of 72 m2 (see 

Lechene et al. (2024) for a detailed examination co-registration error).  

Note that slightly different co-registration procedures are required for DSLR and GoPro models.  While 

DSLR co-registration may only require the use of spheres as reference objects, GoPro co-registration 

also requires the use of reef points to ensure accurate co-registration (see Table 11, Fig. 11). These 

differences improve co-registration over the larger spatial extent of GoPro models. See co-registration 

troubleshooting tips in Appendix 5. 
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Table 9. In-office model processing workflow. 

Step Part/consideration Key tasks Additional info 

Transfer 
files  

Save photos to AIMS 
network drive 
 
 
 
Save Metashape projects 
to AIMS network drive 
 
 
Save metadata to network 
drive 

• Use GoodSync (or alternative back-up software) to transfer photos from the date-
level folder (EcoRAPP\data\DATE) of the field HDD to the following location in the 
network drive: \\pearl\3d-ltmp\EcoRRAP\data 

• Ensure to use a ‘one-way’ back up (not sync) to copy files  
 

• Manually copy project folders from each date-level folder 
(EcoRAPP\projects\REEF\SITE\ZONE\DATE) of the field HDD the respective folder 
in the network drive: e.g. \\pearl\3d-ltmp\EcoRRAP\projects\REEF\SITE\ZONE 

 

• Save the most recent copy of the database to \\pearl\3d-ltmp\EcoRRAP\database 

• Save any other trip files or metadata to the network drive and any other required 
Sharepoint locations 

- \\pearl\3d-ltmp\EcoRRAP\CopyOtherData_MasterSP\TripFiles 
- Teams: TripFiles 

 

• GoodSync 

manual:  

GoodSync 

Tutorial 

 

Prepare 
network 
processing 

Open Agisoft network 
monitor 
 
 
Check network preferences 
in Metashape 

• Connect to AIMS network host:  
        meta-net-03.aims.gov.au or metashape-qmgr.aims.gov.au (same address) 

• Check current network queue is displayed after connecting 
 

• Open Agisoft Metashape and check network preferences are correct  

• Go to: Tools > Preferences  

• Select the Network tab and ensure the following settings are selected: 
       - ‘Enable network processing’ box checked 
       - ‘Host name’ is ’metashape-qmgr.aims.gov.au’ or ‘meta-net-03.aims.gov.au’  
       - ‘Port number’ is 5840  
       - The ‘root’ is set to the UNC path to PEARL:  \\pearl\3d-ltmp  

 
Internal link: 3D 
Modelling 
OneNote 

 

file://///pearl/3d-ltmp/EcoRRAP/data
file://///pearl/3d-ltmp/EcoRRAP/projects/REEF/SITE/ZONE
file://///pearl/3d-ltmp/EcoRRAP/database
file://///pearl/3d-ltmp/EcoRRAP/CopyOtherData_MasterSP/TripFiles
https://aimsgovau.sharepoint.com/:f:/s/RRAPEcoRRAP/EjWuWmlzHStPvPF3dNS8dpwBM97Wv4UTKhE3eo8XB7u9og?e=zx6rSQ
https://www.goodsync.com/tutorial
https://www.goodsync.com/tutorial
file://///pearl/3d-ltmp
https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
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Run chain Ref. models: ‘Chain 2.1’ 
(DSLR and GoPro) 
 
Subs. Models: ‘Chain 2’ 
(DSLR and GoPro)  
 

• Open project in Agisoft Metashape 

• Check previous steps have been completed by checking log and inspecting model 

• If first time using script: Read first lines of script to understand functionality and 
user input (open in script/text viewer) 

• Determine whether to run script on the Network (default) or Locally (on your 
personal computer). Routine processing should take place on the Network. 

• Navigate to Tools > Run Script (or press Ctrl + R) 

• Click the Browse button (folder icon) and navigate to and select script ‘Chain 2.1’ 
for reference models, and ‘Chain 2’ for subsequent model timepoints 

• Click ‘no’ to network processing regardless of the script selected 

• The script will automatically go through the steps described in Table 10 

• Monitor progress of Chain 2 on the Network Monitor (can be > 12 hours to run) 
 

• Note that for 
‘reference’ 
models, Chain 
2 is run in two 
sections: 
Chain 2.1 and 
2.2 (Table 4). 
See more 
details below. 

QA/QC Check alignment and 
model quality 

• If models do not achieve > 80 % alignment conduct troubleshooting (Appendix 5) 

• Visually inspect model for serious and minor mesh issues (Fig. 6) 

• Serious issues include if mesh shape: a) does not accurately represent reef shape; 
b) has a ‘spliced’ axis (multiple axes/planes of points colliding); c) has very large 
holes, or; d) has large sections missing (model does not fill bounding box) 

• Minor issues include if mesh has: a) small holes in corals or benthos; b) holes in 
branching coral thickets; c) holes at margins 

• If the mesh has serious issues record the problem in the Processing log and stop 
processing. Troubleshoot the model (see Appendix 5 for troubleshooting) 

• If the mesh has minor mesh issues: record information in processing log and 
continue processing 

 

• Fig. 6 

• Appendix 5 

Reference 
models 
only:  
Set model 
orientation 
 

DSLR reference only: 
Re-size and position 
bounding box 
 
 
 
 

• Run script: ‘ResizeRegion.py’ 

• After script has run, the bounding box (grey oblong shape) will have changed size 

• Navigate to Workflow > Build Mesh, and select Sparse Cloud as the source (all 
other options as default) and make a mesh to check bounding box placement 

• Check that the bounding box is located in the centre of the plot. Refer to sphere 
trees as visual markers of plot location (Fig. 6a-d). 

• Table 4 

• Fig. 6 
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Reference 
models 
only:  
Set model 
orientation 
cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DSLR reference only: 
Re-size and position 
bounding box cont. 
 

• If bounding box needs to be moved or rotated use the ‘Move bounding box’ and 
‘Rotate bounding box’ tools (Fig. 6e,f). 

• Ensure to re-select the ‘arrow’ tool once bounding box adjustment is complete 

• Navigate to Workflow > Build Mesh, and select Sparse Cloud as the source (all 
other options as default) to re-make the mesh to check adjusted bounding box 
placement  

• Repeat process as required 

Note: This step is 
best completed 
on a computer 
with good GPU 
capabilities due 
to long loading 
time and lag 
caused by large 
models 
 

DSLR & GoPro reference:  
Orient model to horizontal 
layout using ‘Orient tool’ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click the ‘reset view’ button (box with four arrows in central top toolbar) 

• Visually determine the bottom edge of the plot (picket A on the left), generally 
the deeper side of the plot 

• Open on-screen protractor app (e.g. PicPick or other application) and measure the 
angle between a line drawn parallel with the bottom edge of the model extent 
and the horizontal guide (Fig. 7a,b) 

• Enter this value in the input cell of the ‘Orient tool’ : 
Model_rotation_tool_JHarianto_V2.xlsx (Fig. 7c) 

• Ensure the value is entered as a negative or positive value depending on whether 
a clockwise or anti-clockwise rotation is required, respectively (Fig. 7c) 

• Open the reference pane of the Metashape project and identify the type of triad 
used by the x, y, coordinates entered (see key in Orient tool tab) and/or by 
visually examining the triad 

• To view triad: Right click a triad marker in the reference pane and select ‘Sort 
photos by marker’ and double click the photo to load 

• Copy the output x and y values for the left and right triad marker from the Orient 
tool then double click and paste these values to the respective boxes in the 
reference pane (Fig. 7d) 

• Click the ‘Refresh’ button then then ‘Reset view’ button in the reference pane to 
update model orientation 

• You should then see the model move to a new position  

• Repeat these steps if correct model orientation is not achieved 
 

• Fig. 7 

https://picpick.app/en/
https://aimsgovau.sharepoint.com/:x:/s/RRAPEcoRRAP/EXQN7pYY1ClAhrGPCal-5EgBayJBspO3GHyXkDis7H3HaQ?e=G4mm0Z
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GoPro reference only: 
If all plots imaged together, 
split into Plots 1&2 and 
3&4  

• Right-click model and select ‘Duplicate model’ twice to generate 3 x copies 

• Rename models to ‘WholeArea’, ‘P1P2’, and ‘P3P4’ (Fig. 8a) 

• Select model ‘P1P2’ and crop the model using the rectangular selection tool and 
delete key to exclude all areas of the model from the start of P3 to the end of the 
area (Fig. 8b,c) 

• Select ‘no’ when asked if you want to remove markers 

• Repeat for model ‘P3P4’ removing all areas of the model from the end of P2 to 
the beginning of the area (Fig. 8d,e) 

 

• Fig . 8 
Note: Use the 
location of 
markers to 
estimate plot 
extents when 
cropping 

DSLR & GoPro reference:  
Visually inspect plot to 
determine if slope ≥ 45o 

 

• If the plot represents a section of reef that is a wall, steep slope, or does not suit 
top-down orientation, the model needs to be rotated to a 60o orientation 

• Fig. 9 
Note: A 60o 

rotation was 
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• This can be determined visually for most plots by clicking the ‘reset view’ button 
and examining reef structure and whether most corals are directly visible from 
this orientation (Fig. 9a,b) 

• If unsure, use an on-screen protractor tool (PicPick) to measure the general angle 
of the slope relative to horizontal axis  

• Record selected orientation in log (‘TopDown’ or ‘60o’) 
 

selected to 
standardise 
model view for 
steep 
environments 
where a top-
down orientation 
was not suitable 
(i.e. majority of 
corals obscured 
or not visible) 
 
 
 
 
 
 
 
 
 
 
Note: There is no 
functionality to 
‘undo’ 
transformations 
made using in the 
‘Object’ tab of the 
Geobit helper 
tool. To avoid 
errors, ensure the 
project is saved 
prior to 
manipulation and 

 DSLR & GoPro reference:  
If slope ≥ 45o:  
Duplicate chunk and 
rename ‘_60D’ 
 

• Right-click chunk and select ‘Duplicate chunk’ 

• Right-click chunk, select ‘rename’ add ‘_60D’ to end of chunk name 
 

 
 
 
 
 
 
 
 
 
 
Reference 
models 
only:  
Set model 
orientation 
cont. 

DSLR & GoPro reference:  
If slope ≥ 45o:   

Rotate model 60o using 
Geobit helper tool 
 
 
 
 
 
 
DSLR & GoPro reference:  
If slope ≥ 45o:   

Rotate model 60o using 
Geobit helper tool cont. 
 

• Run Geobit helper tool script (Fig. 9c) 

• Navigate to Tools > Run Script (or press Ctrl + R) 

• Click the Browse button (folder icon) and navigate to and select script 
‘ PS170_geobit_helper.py’ 

• Click ‘no’ to network processing 

• A new tab called ‘Helpers’ will now be displayed beside ‘Help’ on the top toolbar 
of Metashape 

• Navigate to Helpers > Geobit Transform 

• In the ‘View’ tab, enter ‘60’ into the ‘Step value’ box and click the arrow 
corresponding to the X or Y axis, depending on model orientation (generally this is 
the right ‘X’ arrow, Fig. 9d). This will not change the model rotation, so can be 
changed multiple times and reset by clicking the ‘reset view’ button  

• Assess whether a 60o model rotation is correct and more suitable than top-down 
orientation for the plot (i.e. more corals are directly visible)(Fig. 9d) 

• If 60o model orientation is appropriate, click the ‘Reset view’ button 

• If 60o model orientation is not appropriate, repeat this process trying alternate 
buttons (i.e. Y instead of X) and re-assess 

• If 60o orientation is less suitable than top-down, click the ‘Reset view’ button and 
continue to the export mesh step (skip next four points) 
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• In the ‘Object’ tab, click ‘OK’ to the warning, enter a value of 60 into the ‘Step 
Value’ box and click the left or right arrows on Omega, Phi, or Kappa buttons 
(corresponding to X,Y or Z, generally this is the left ‘Omega’ arrow)(Fig. 9d).  

• In the ‘Region’ tab, click the ‘Align to view’ button to adjust the bounding box (Fig. 
9e), the grey frame of the bounding box should now move around the model 

• Close the Geobit helper window and click the ‘Reset view’ button to check the 60o 

orientation has been saved 

exit without 
saving to cancel if 
required 
 
 
 

    
Reference 
models 
only:  
Run chain 
 

DSLR & GoPro reference:  
Run Chain 2.2 

• If first time using script: Read first lines of script to understand functionality and 
user input (open in script/text viewer) 

• Determine whether to run script on the Network (default) or Locally (on your 
personal computer). Routine processing should take place on the Network. 

• Navigate to Tools > Run Script (or press Ctrl + R) 

• Click the Browse button (folder icon) and navigate to and select script ‘Chain 2.2’  

• Click ‘no’ to network processing  

• The script will automatically go through the steps described in Table 10 

• Monitor progress of Chain 2.2 on the Network Monitor (can be > 12 hours to run) 
 

 

All models: 
Export 
mesh 

Export textured mesh (.ply) 
 

• Once jobs are completed, re-open project and examine mesh  

• Record progress in processing log and make note of any mesh issues (Fig. 5) 

• Right click the model in the workspace pane and select ‘Export model’ 

• Navigate to the export location: //pearl/3d-
ltmp/EcoRRAP/Outputs/TexturedMeshes/ 

• Save the mesh as a ‘.ply’ with the same name as project file with the suffix ‘_ref’ 
for ‘reference’ models and ‘_unr’ for ‘test’ or ‘unregistered’ meshes 
(ie. REEF_SITEZONE_PLOT_YEAR_ref, or  REEF_SITEZONE_PLOT_YEAR_unr)  

• Click ‘no’ to network processing 

• Mesh should take < 2 minutes to export 
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Table 10. Metashape Professional v 1.7.6 processing steps involved in processing Chain 2 (Chain 2.1, 2.2). Note: For ‘reference’ models Chain 2 is run in two 

parts (Chain 2.1 and 2.2) with manual steps and individual scripts run between (see Table 9 for details). Jobs that are only present in Chain 2.1 and 2.2 are 

shown in blue text.  

Chain no. Job name Job description Settings used  
(DSLR and GoPro, (bolded if GoPro differs) 

Chain 2.1 High quality alignment • Resets initial camera alignment and re-aligns points at 
high quality  
 

• Accuracy: High 

• Generic preselection: Yes 

• Reference preselection: Source 

• Key point limit: 40,000 

• Tie point limit: 0 

• Exclude stationary tie points: Yes 

• Guided image matching: No 

• Adaptive camera model fitting: No 

• Reset alignment: Yes 

• Minimum alignment: 80 % 
 

 Calculate scalebar error • Calculates and checks scale bar error as per Chain 1, 
step 4 

• Stores results in a list that is printed at script 
completion 
 

 

 DSLR Chain 2.1: 
Resize bounding box 
 

• Resizes bounding box to size of required ‘plot’ size  • DSLR plot size: 12 x 6 x 10 m (x, y, and z, respectively) 

Chain 2.2 Duplicate chunk • Duplicates chunk to preserve unedited point cloud 
(failsafe) 

 

Chain 2.2 
cont. 

DSLR Chain 2.1:  
Crop point cloud 
 

• Removes all sparse cloud points outside bounding box 
 

 

 Initial camera optimization • Performs an adjustment procedure using coordinates, 
depths, scale bars, and corresponding accuracies, to 
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refine exterior and interior camera orientation 
parameters and tie-point coordinates  
 

 Filter and re-optimize cameras • Filters point cloud by: 
o Selecting points with a reconstruction uncertainty 

> the ‘maximum reconstruction uncertainty’ and > 
‘minimum projection accuracy’  

o Checking if the selected points > ‘maximum point 
cloud percentage’ and deletes points up to the 
‘maximum point cloud percentage’ 

• Re-optimizes cameras 

• Performs 5-step loop of reprojection error 
improvement (repeatedly removing the worst 
‘percentage point cloud removal’ of current point 
cloud) by: 
o Checking reprojection error before each iteration 
o Optimising after each iteration 
o Using the ‘target reprojection error’  
o Loop stops when either the target value is reached, 

or point cloud size falls < ‘minimum point cloud 
size’ of the original size (whichever comes first) 

• Performs final full optimisation of cameras 
 

• Maximum reconstruction uncertainty: 10 (50) 

• Minimum projection accuracy: 3 (10) 

• Target reprojection error: 0.5  

• Maximum point cloud percentage: 50  

• Percentage point cloud removal: 10 

• Minimum point cloud size (%): 30 

 Build depth maps • Generates multiple pair-wise ‘depth maps’ from 
overlapping image pairs considering their relative 
exterior and interior orientation parameters. These are 
merged into a combined depth map of the plot from 
which a mesh can be made. 
 

• Filtering: Mild 

• Reuse depth maps: No 

• Maximum neighbours: 40 

• Maximum group size: 100 
 

 Build mesh • Reconstructs a polygonal mesh model based on depth 
maps data  
 

• Source data: Depth map 

• Surface type: Arbitrary (3D) 

• Depth map quality: Medium (High) 

• Facecount: High 
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• Custom facecount: 200,000 

• Interpolation: Enabled (default) 

• Depth filtering: Mild 

• Point classes: All 

• Calculate vertex colours: Yes 
 

 Build texture 
 

• Builds texture for the model 
 
 

• Texture type: Diffuse map 

• Source data: Images 

• Mapping mode: Generic 

• Blending mode: Mosaic (default) 

• Texture size: 8192 

• Enable hole filling: Yes 

• Enable ghost filter: No 
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Figure 5. Examples of serious alignment and mesh (digital surface model, DSM) issues: a) an aligned 

point-cloud with a deformed reef structure showing multiple intersecting ‘spliced’ axes likely caused 

by errors in marker detection or image collection; b) a DSM with  significant holes in mesh, potentially 

due to imaging in poor visibility or the presence of moving benthic cover; c) a DSM with large  gaps 

at the edge of the area (not rectangular in shape) likely caused by the diver not swimming wide 

enough when imaging the plot; d) a DSM with consistent holes throughout a branching coral thicket. 

Depending on the cause of these issues they may/may not be able to be solved through processing, 

however all should be examined to determine the cause of the issue. 

A 

B 

C 

B 
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Figure 6. Visual check and adjustment of bounding box placement, note star-pickets are 

circled in white: a) Initial bounding box not centred on plot; b) bounding box rotated; c) 

bounding box moved; d) mesh re-made to new bounding box location. Note: Red square 

shows the location of the ‘rotate’ and ‘move’ bounding box tools. 
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 Figure 7. Measuring and adjusting model orientation using onscreen protractor (PicPick) showing: a) line drawn perpendicular to bottom model 

extent; b) angle measured from line to horizontal guide; c) angle entered into Orient tool (circled left) and X and Y outputs to be copied from 

(circled right), and; d) X and Y coordinates copied from orient tool are entered into triad marker coordinates in reference pane (cells circled) then 

the ‘refresh’ button (circled left) and ‘reset view’ button (circled right) are clicked to update the model. 

C 

A B 

D 
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Figure 8. Steps involved in duplicating and splitting GoPro models between plots: a) right click model and select ‘Duplicate,’ then rename as shown 

to ‘WholeArea’, ‘P1P2’, and ‘P3P4’; b and c) select and delete model areas of plots 1 and 2; and d) Duplicate the model locally; e) select the model 

that was duplicated and select the 'Undo' botton. Once the previously deleted area appears, select 'Crop Selection' to keep plots 1 and 2. Note: 

locations of markers and sphere trees are used as guides to indicate plot location. 
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 Figure 8. Assessing and adjusting model orientation: a) well-suited top-down oriented model; b) badly suited top-down oriented model; c) Geobit 

helper tool; d) 60 model rotation, and; e) bounding box adjustment. 
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Table 11. Model co-registration workflow. 

Step Part/consideration Key tasks (DSLR and GoPro, (bolded if GoPro differs) Additional info 

CloudCompare Import ‘reference’ 
and ‘test’ 
(subsequent 
timepoint) meshes 
 
 

 
Rename reference 
mesh 
 

• Open CloudCompare 

• Navigate to File > Open > Select .ply models files (or drag and drop into CloudCompare) 

• In the ‘File Open dialog’ leave all the fields as default and click ‘Apply’ (or ‘Apply all’ if 
multiple entities are selected) 

• Note: GoPro models should be co-registered as P1P2 and P3P4. Co-registering models 
containing all plots (P1,2,3,4) results in unacceptably-high error 
 

• Unclick the mesh view check-box in left pane tree to speed up loading time (Fig. 10a) 

• Rename the ‘reference’ mesh by double clicking its name in the left pane 

• Rename the ‘reference’ mesh to ‘ref’ to avoid confusion in following steps (Fig. 10b) 
 

Figs. 10,11 

 Transform meshes 
into point clouds 
 

• Select both meshes in the left pane (CTRL + click both)(Fig. 10c) 

• Click ‘Sample points on a mesh’ button 

• Change the point density to for meshes 100,000 (50,000), click OK (Fig. 10c) 

• You will now see two *.sampled point clouds in the left pane (Fig. 10d) 
 

 

 Select both point 
clouds and click 
alignment by 
spheres 

• Select the reference and the ‘test’ (subsequent timepoint) sampled clouds (CTRL+ click) 

• Click the ‘Align by picking points’ tool (Fig. 10e) 

• In the Entity Selector dialog, select the ‘test’ point cloud to be registered (referred to as 
‘aligned’ or ‘to align’, depending on the CloudCompare version) and click OK (Fig. 11a) 

• In the point-pair registration dialog (right top corner by default), click the white sphere 
icon and set the search radius to r = 0.05 and RMS to RMS < 100 % (Fig. 11b) 
 

 

 
 
 
 
 
 
 

Click the centre of 
the ‘reference’, then 
‘test’, spheres 
 
 
 
 

• Visually check that both point clouds have the same number of spheres reconstructed  

• Rotate the cloud so the sphere tree is clearly visible without the presence of obscuring 
shapes in the foreground (left-click to rotate, right-click to pan, middle-click to zoom in 
and out 
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CloudCompare 
cont. 

Click the centre of 
the ‘test’, then 
‘reference’, spheres 
cont.  

 

• Check or un-check the ‘Auto-update zoom’ box in the bottom left corner of the sphere 
alignment dialogue box to turn on/off automatic model centring when switching 
between models 

• Starting with the reference point cloud (uncheck show ‘to align’ entities to avoid 
confusion between the point clouds), click the centre of the spheres (Fig. 11c) 

• A new entry will appear for each sphere centre picked in the corresponding table and a 
colour sphere will appear (Fig. 11c) 

• Keep picking the centre points for the following number of spheres: 
- DSLR: All spheres present 
- GoPro: 2 spheres per tree, total 8 spheres per model  

• Repeat this process for the ‘to align’ point cloud, ensure you remember the order you 
select the spheres, it must be the same for both models 

• Tips: 
- Delete spheres by clicking the red cross at the end of the table. To remove a single 

sphere, click the red cross and select ‘No’ to remove equivalent point. To remove a 
pair of spheres, click the red cross and select ‘Yes’ to remove equivalent point 

- For GoPros, if spheres are not completely reconstructed, you can increase the 
default point size to make it easier to identify the spheres. Default point size 
options appear on the top left of the 3D view window 

 

Figs. 10,11 
 

 For GoPro only: Add 
additional 4 points 
manually 
 

• Once 8 sphere-pairs have been selected click ‘align’ 

• For GoPro co-registration, add an additional 4 x points on the reef by de-selecting the 
‘sphere icon’ (Fig. 11b) and dropping points (Fig. 11e) 

• Drop points on clearly identifiable features present on the reef located above and 
below the centre of plots 1 & 2 and 3 & 4 (Fig. 11e) 

• The addition of these points helps improve GoPro model co-registration over large 
areas 
 

 

CloudCompare 
cont. 
 
 
 

Check co-
registration 
 
 

• Once all pairs have been selected click ‘align’ 

• CloudCompare will give a view of the registered point clouds, RMS (value in top-centre 
of window), and error of each point pair (in table), 

• Visually check the co-registration for: 
- How well the two models are aligned (e.g. are corals in the same location?)  
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CloudCompare 
cont. 
 

Check co-
registration cont. 
 
 
 
 
 
 
 
 

- The model RMS (‘root mean square,’ the overall distance between clouds) 
- The error of each point pair (‘Error’ in the top right table) 

• If one or several pairs are not well aligned (e.g. if sphere trees have moved) variation in 
their position in 3D space will be visible and their Error will be higher. This will 
negatively influence the overall co-registration (see screenshots below) 

• Delete point-pairs that are not well aligned and click ‘yes’ to ‘remove equivalent point’ 
to remove the pair. As a general rule, the RMS and point pairs should have an error of: 
- < 0.04 for DSLR model co-registration 
- < 0.07 for GoPro co-registration 

• Repeat this process, adding/removing point pairs until the above requirements are 
met, see Appendix 5 for troubleshooting. Aim to keep a minimum of 3 sphere-pairs in 
total for DSLRs and 4 sphere-pairs for GoPros, and at least one pair on each tree 

• If sphere trees and starpickets have moved significantly between timepoints, or co-
registration error needs to be improved, additional benthic points can also be added 
during DSLR co-reg (as per GoPro steps) and spheres can be removed as required 

• Once co-registration looks visually suitable and the above error values are achieved, 
click ‘align’ again and conduct a final check on visual model alignment, RMS, and pair 
error 

Figs. 10,11 
 

    
 Apply co-registration • When satisfied, validate the co-registration by clicking the green tick. The current 

registered point cloud can be reset by clicking ‘reset’ 

• Once applied, CloudCompare will display the final RMS and transformation matrix  

• Note: this information will also appear in the Console and the matrix will also be 
displayed in the Properties when selecting the registered point cloud in the left pane 
 

 

 Export 
transformation 
matrix 

• Copy and save the transformation matrix into a text document 

• Select the ‘test’ (aligned) model mesh in the left pane 

• Navigate to the left Properties pane > Scroll and click on the Transformation matrix tab 
> Export tab > select Clipboard (the console will show it has been ‘copied to clipboard’)  

• Open an empty text editor page (e.g. Notepad) and click ‘Paste’ to input the matrix 

• The matrix should contain 16 numbers in a 4 x 4 arrangement 

• Save the file under the name of the model to be applied to as a .txt file 
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Metashape Open ‘test’ (non-

reference) 
Metashape project 
 
 
For GoPro only: 
Duplicate chunks  

• Open Metashape project to be co-registered 

• Select the chunk to be registered (double-clicked and bolded) 
• Ensure the chunk is duplicated and re-named as ‘_60D’ if reference model has been 

rotated (if rotated, there should be chunks named  ‘_TopDown’ and ‘_60D’) 
 

• Note: Transformation matrices will be applied to all models with in a chunk. Since 
multiple GoPro models are present within a chunk (P1P2, P3P4, WholeArea) chunks 
need to be duplicated to ensure there is one chunk per model before applying 
transformations 

• Right click the chunk with models to be co-registered and select ‘Duplicate chunk’ 

• Once complete, rename the chunk relative to the model to be co-registered (e.g. 
‘P1P2’, or ‘P1P2_60Deg’) 

• Delete the duplicate model not being used from the chunk (e.g. Model P3P4 if co-
registering P1P2) by right-clicking the model and selecting ‘Remove model’ 

• Note: Models of the ‘WholeArea’ can stay within chunks 
 

 

 Run ‘Chain 3’  
 
 
 
 

 
For DSLR only:  
Specify bounding 
box reference file 
 
 
 
 
For DSLR only:  
 

• Navigate to Tools > Run Script (or press Ctrl + R) 

• Click the Browse button (folder icon) and navigate to and select script ‘Chain 3’ 

• Click ‘no’ to network processing  

• When prompted, navigate to and select the model transformation matrix where it is 
saved, e.g. \\pearl\3d-ltmp\EcoRRAP\outputs\TransformationMatrixes  
 

• For DSLR only: When prompted, navigate to, and select, the location of the current 
project and the reference project to specify bounding box extents 

• When script is running, the current and reference bounding box projects will load, 
before returning to the original project.  
 

• Once script is applied (instantaneous) model orientation will visibly change 
 

• Once script is applied model bounding box (as well as model orientation) will visibly 
change 

 

file://///pearl/3d-ltmp/EcoRRAP/outputs/TransformationMatrixes
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Figure 9. Steps for model co-registration in CloudCompare: a) import meshes; b) rename 

reference mesh, c) subsample mesh; d) subsampling completed; e) select meshes and click align 

tool (green and red sphere icon). Steps are continued in Fig. 11. 
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Figure 10. Steps for model co-registration in CloudCompare, continued from Fig. 9: a) select 

‘test’ model as ‘aligned entity’; b) select sphere icon and set ‘r’ to 0.050, and RMS to 100; c) click 

‘test’ spheres in order from top to bottom of each tree; d) repeat for ‘reference’ spheres, 

making sure to select spheres from both meshes in the exact same order, and; e) GoPro model 

showing location of selected spheres (R1-7) and additional benthic points (R8-11) used for 

model co-registration of two plots. 
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4.3 Output generation and post-processing 

4.3.1 Output generation 

Once models have been processed, co-registered, and set to the appropriate orientation, the final 3D 

models can be exported 2D orthomosaics can be generated and exported. These final output 

generation and export steps are described in Table 12.  

 

All EcoRRAP final model output are available via AIMS data servers in the following locations: 

o 3D models 

o  EcoRRAP Digital Surface Models | AIMS Data Repository | aims.gov.au 

o 2D orthomosaics 

o EcoRRAP Benthic Orthomosaics | AIMS Data Repository | aims.gov.au 

 

4.3.2 Output post-processing 

Depending on the intended use of final 3D models and 2D orthomosaics some output post-processing 

steps may be required (see Table 12, Fig. 12, Appendices 6,7). For example, the following steps are 

only required if outputs are to be used for: 

 

• Orthomosaic annotation in Taglab 

The current EcoRRAP workflow involves annotation of 2D orthomosaics within the software 

Taglab (Pavoni et al. 2021). This workflow is described in SOP 3: Annotation and metric extraction 

(Table 1, Fig. 1). Taglab requires that orthomosaic pixel extent is identical between orthomosaics 

of different timepoints. Although the current workflow produces model with identical 

coordinates, and for DSLRs identical bounding box extents, often this does not translate to 

identical orthomosaic pixel extents once generated. Accordingly, prior to use in Taglab, 

orthomosaics are clipped to the same pixel extent in ArcGIS using the ‘Extract by mask function’ 

(see Table 12, Fig. 12). This step is therefore not required in any application where orthomosaic 

pixel extent does not need to be identical between timepoints. 

 

• 3D model upload to SketchFab 

The current EcoRRAP workflow also involves uploading some models to the EcoRRAP SketchFab 

page (3D model collections by EcoRRAP (@AIMSEcoRRAP) - Sketchfab. The purpose of uploading 

models to SketchFab is to increase accessibility and visibility of EcoRRAP models to the public and 

potential collaborators. Note that models housed on SketchFab are of reduced file quality and 

size, therefore collaborators wanting to extract data from these models should request the full-

size files be shared. Before uploading to SketchFab models require reduction in file quality/size 

(called ‘decimation’) needs to be completed, these steps are described in Appendix 6.   

 

 

https://apps.aims.gov.au/metadata/view/9fb02277-0237-4098-b284-faad6fe3f397
https://apps.aims.gov.au/metadata/view/c785d756-d250-4a5f-875f-9fa3e57cdd82
https://sketchfab.com/AIMSEcoRRAP/collections
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• Colour correction of GoPro orthomosaics  

While DSLR models images are currently colour-corrected using in-camera in-water white 

balancing techniques (see SOP 1) in the EcoRRAP workflow, in-camera white balance is not 

effective for GoPros. Accordingly, until improved colour correction workflows for imagery are 

incorporated into the EcoRRAP workflow (e.g. using SeaThru algorhythms, (Akkaynak & Treibitz 

2019)) it is recommended to colour correct GoPro orthomosaics after generation. These steps 

can be completed using a number of platforms, however an example of this is provided for 

Photoshop in Appendix 7.  

 

4.4 Metric extraction 

A very wide range of ecologically informative data can be extracted from the final 2D and 3D outputs 

generated by the current EcoRRAP 3D processing workflow. The current workflow was primarily 

designed to enable the extraction of data relating to: 1) 2D benthic community data (e.g. benthic 

community composition and benthic cover); 2) 2D taxa demographic data (e.g. growth and mortality 

rates of benthic taxa); and 3) 3D benthic complexity data (e.g. surface area and rugosity)(Fig. 1). The 

workflow used to generate this data is detailed in ‘SOP 3: Annotation and metric extraction’ for all 

2D metric extraction and section 3.7.1 for 3D complexity metric extraction steps.  

In addition to the above data, the current 2D and 3D model outputs can also be used to generate 

data on 3D taxa demographic data, spatial landscape (seascape) ecology, and many other ecological 

metrics. As EcoRRAP techniques and data extraction workflows are developed they will be 

incorporated into the current document and internally within the AIMS 3D Modelling Teams page 

here. For more information regarding ‘Next steps’ see Section 4 ‘Next steps and additional 

resources’. 

 

4.4.1 3D Complexity metric extraction 

The process described below is the current technique used by EcoRRAP to extract 3D complexity 

metrics from models (.ply). Steps and files presented here have been developed by Mitch Bryson 

('ComplexityMetrics' tool), Ryan Krensel ('MetricsCalc' tool), Renata Ferrari and Will Figueira 

(integrated workflow and 'Complexity bat file builder'). For full details, method explanation, and 

background information please see documents in the AIMS GitHub and internally in the AIMS Tool 

explainer and Source files folders. Any use of this technique and resultant extracted metrics should 

reference these authors accordingly.  

A detailed workflow description for applying the above 3D complexity metric extraction tools to 

EcoRRAP 3D model outputs (in specified folder structures) is provided in section 3.7.1. For updated 

information and AIMS-specific details see internal 3D Modelling Sharepoint page here. 

 

. 

 

 

https://teams.microsoft.com/l/entity/0d820ecd-def2-4297-adad-78056cde7c78/_djb2_msteams_prefix_2977735146?context=%7B%22channelId%22%3A%2219%3A393b6870a3e141c98a95a8a291611ba1%40thread.tacv2%22%7D&tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac
https://github.com/open-AIMS/EcoRRAP
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EiYfCg6xO7tIvLBFX4Zhj-kBLkjUbYFBBwBoUPVa8FW-dg?e=g6IaJM
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EiYfCg6xO7tIvLBFX4Zhj-kBLkjUbYFBBwBoUPVa8FW-dg?e=g6IaJM
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EvqtfyQRg-VBrj5XnpjyH3cBdheDINRANEDKc-p2s3RsWg?e=IyO8jU
https://aimsgovau.sharepoint.com/sites/3Dmodelling/_layouts/15/Doc.aspx?sourcedoc=%7bbf6b30ef-9fc4-4a12-8d8d-5e73567ec3dd%7d&action=edit&wd=target%28General.one%7Cfd467a86-1542-4f91-be13-26e1d02f5985%2F3D%20Complexity%20Metric%20Extraction%20%28USYD%20Technique%5C%29%7C26e01b9b-05fd-42a3-83fd-a3f30befc215%2F%29&wdorigin=703
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Table 12. Final 3D and 2D output generation and export steps. 

Step Part/consideration Key tasks (DSLR and GoPro, (bolded if GoPro differs) Additional 
info 

Export final 3D 
model 

Export textured 
mesh (.ply) 
 

• Open Metashape project  

• Right click the Model to be exported in the workspace pane and select ‘Export model’ 

• Navigate to the export location: //pearl/3d-ltmp/EcoRRAP/Outputs/TexturedMeshes/ 

• For reference models: Save the mesh in .ply format under the project file name (ie. 
REEF_SITEZONE_PLOT_YEAR) with the suffix ‘_ref’ within the Reference meshes subfolder  

• For coregistered non-reference models: Save the mesh in .ply format under the project file 
name (ie. REEF_SITEZONE_PLOT_YEAR)  within the Co-registered meshes subfolder 

• Click ‘no’ to network processing 

• Mesh should take < 2 minutes to export 
 

 

Generate 
orthomosaic 
 
 
 
 
 
 

Process orthomosaic 
 
 
 
 
 

• Check for missing photos before orthomosaic generation 

• Right click any photo and select ‘Check path,’ and ‘Entire workspace’ 

• A dialogue box will then check file paths and either confirm no files are missing or identify 
missing photo files (see Appendix 5 for troubleshooting if files are missing) 

• Check network processing preferences are correct 

• Navigate to Workflow > Build Orthomosaic 

• In the Orthomosaic window: 

• Select : Planar (Type), Top XY (Project plane) 

• Check the refine seamlines box (leave un-checked for GoPros) 

• Keep other settings as default 

• Click ‘Yes’ to network processing (monitor progress in Network Monitor) 
 

 

 
 
 
 
 
 
 

Export orthomosaic 
(tiff) 
 
 
 
 
 

• Once the orthomosaic has finished processing, open the Metashape project 

• Double click on the orthomosaic in workspace pane to view 

• Right click the orthomosaic in the reference pane and select ‘Export orthomosaic’ 

• If using Orthomosaics in Taglab (EcoRRAP workflow protocol) 
- In the Export Orthomosaic pane > Check the ‘Max. dimensions (pix)’ box and enter 

‘32000’ into the dialogue box and keep all other settings as default.  
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Generate 
orthomosaic 
cont. 
 
 

Export orthomosaic 
(tiff) cont. 
 

• Navigate to the export location: //pearl/3d-ltmp/EcoRRAP/Outputs/Orthomosaics 

• Save the orthomosaic as a .tiff under the project file name (ie. REEF_SITEZONE_PLOT_YEAR) 
within the year subfolder 

• Exporting will take approx. 2-5 minutes per orthomosaic, so can be completed via local 
processing or network if required. 
 

Clip test (non-
reference) 
orthomosaics 
to reference 
extent 

Note: This step is only required if orthomosaics are to be used in Taglab or another application that requires orthomosaics to have 
identical pixel extents between years (i.e. between reference and test (non-reference) orthomosaics) 
 

Launch ArcGIS Pro • Launch ArcGIS Pro 

• Click ‘Start without template’ 

• Navigate to Insert > New Map 
 

Figs. 
12,13 

 Import orthomosaics • Drag and drop the reference and test (non-reference) orthomosaic from a file explorer 
window onto the map (Fig. 12a) 

• Select ‘No’ if asked whether to ‘calculate statistics’ during orthomosaic import 

• Right-click an orthomosaic in the contents pane and select ‘Zoom to layer’ to view (Fig. 12b) 

• Visually check that orthomosaics align well (corals in same location) by checking/un-
checking the orthomosaic layer in the map pane (Fig. 12c) 

• If orthomosaics do not align well, troubleshoot co-registration and model generation 
(Appendix 5) 
 

 

 
 

Apply reference 
dimensions 
 
 

• Navigate to Analysis > Tools > Geoprocessing to open this pane on the screen  

• In the Geoprocessing pane, search for the ‘Extract by Mask’ tool and click to load (Fig. 12d) 

• Select the test (non-reference) orthomosaic layer as the ‘Input raster’ (Fig. 12e) 

• Select the reference orthomosaic layers as the ‘Feature mask’ 

• Leave the output raster name and location as default 

• Click Run (the process can take a few minutes) 

• The new orthomosaic will appear in the left map contents pane when complete (Fig. 12f) 
 

 

 
 

Export edited 
orthomosaic 

• Right-click the newly created orthomosaic in the contents pane and select > Data > Export 
Raster (Fig. 13a) 

 

file://///aimsgovau.sharepoint.com/aimsgovau.sharepoint.com/pearl/3d-ltmp/EcoRRAP/Outputs/2022
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Clip test (non-
reference) 
orthomosaics 
to reference 
extent cont. 
 
 

 
 
 
 
Export edited 
orthomosaic cont. 
 

• In the Export Raster pane (Fig. 13b): 
- Change the Output Raster Dataset location to the required folder within 
\\pearl\3d-ltmp\EcoRRAP\outputs\Orthomosaics 

       - Name the ortho ‘ClusterReef_SiteZone_Plot_YearMonth_c.tif’ 
       - Select ‘WGS 1984 Web Mercator (auxillary sphere) as the ‘Coordinate system’ 
       - Select ‘Same as Layer,’ and select reference orthomosaic for ‘Clipping Geometry’ 
       - Tick the box ‘Maintain Clipping Extent’  
       - Change the columns and rows input to match the pixel extent of the 
          reference orthomosaic 
       - To check pixel extent of the reference orthomosaic, right-click the 
         orthomosaic in the contents pane and select > Properties > Source > Raster 
         Information (Fig. 13c) 
       - Leave the rest as default (making sure format is TIFF) 
       - Click ‘Export’ 

  • Once exported, the orthomosaic will appear as a new layer in the contents pane (Fig. 13d) 

• You can now close the ArcGIS project without saving (or start cropping next orthomosaic) 

 

file://///pearl/3d-ltmp/EcoRRAP/outputs/Orthomosaics


   
 

39 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11. ArcGIS steps used to crop ‘test’ (non-reference) orthomosaics to the pixel extent of reference orthomosaics: a) Importing orthomosaics; b) viewing 

orthomosaics; c) checking orthomosaic features line-up between timepoints; d) loading ‘extract by mask’ Geoprocessing tool; e) setting extract by mask 

parameters; f) extracted layer present in contents pane. Steps continued in Fig. 13. 
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Figure 12. ArcGIS steps used to crop ‘test’ (non-reference) orthomosaics to the pixel extent of reference orthomosaics, continued from Figure 12: 

a) exporting new layer; b) specified export settings; c) viewing pixel dimensions of reference orthomosaic, and; d) final exported orthomosaic 

visible in contents pane. 
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Table 13. 3D benthic complexity metric extraction workflow adapted to EcoRRAP data and folder structure from Mitch Bryson ('ComplexityMetrics' tool), 

Renata Ferrari and Will Figueira (integrated workflow and 'Complexity bat file builder').  

Step Key task Additional info for EcoRRAP users 

Download files • Download all files 
- Externally:  AIMS GitHub  
- Internally: Tool download folder (3D 

Modelling Sharepoint)  
- EcoRRAP: These files are already downloaded and 

stored in PEARL here:  \\pearl\3d-
ltmp\EcoRRAP\outputs\Complexity_Metrics\Complexit
yTools\USYD-EcoRRAP_Tool  
 

• This tool can be run from the existing location in PEARL 
without needing to re-download files 

 
 

Open the 
'ComplexityBatBuilder.
xlsm' file and edit 
inputs 

• Input cells are shown in green (pale & bright) and can all be 
altered to suit the required application  
- For an in-depth description of each of these inputs see 

resources in the Tool explainer folder  
- Default settings are provided in the file to 

suit EcoRRAP workflow (72 sq. m plots)  

- Select ‘No’ to 

• This tool can be run on model files located in a single 
folder, or multiple folders by:  
- Selecting the input from the drop-down in cell B12, and 

entering either the:  
- Source folder in cell B13, for models a single folder, or  
- Source file paths in cells B29-onwards, for models 

in multiple locations  
- Regardless of which location format is selected, you will 

need to enter the model names in cells A29 onwards  

•   Note if running script on files stored in a network drive: 

• Create a copy of this file in the same location (to keep 
the example file unchanged as a template) and change 
the inputs in the bright green cells only:  

- Your model locations (see comments above re 
single/multiple model locations), e.g. Example model 
files provided in:   
Z:\EcoRRAP\outputs\Complexity_Metrics\Complexity
Tools\USYD-EcoRRAP_Tool\Example\Models  

- Location for output metrics files, e.g. metric outputs 
saved in:   
Z:\EcoRRAP\outputs\Complexity_Metrics\Complexity
Tools\USYD-EcoRRAP_Tool\Example\MetricsFiles  

- If running this script on the example files, ensure the 
'MetricsFiles' folder is empty (delete files) prior to 
running.  

- Check outputs against files in the 
'ExampleOutputs_MetricsFiles' folder  

https://github.com/open-AIMS/EcoRRAP
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/ErjADhu67S5MrJdu_KJq5t4BredJcEuGxVsCalq3dfhigA?e=dC3Ada
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EiYfCg6xO7tIvLBFX4Zhj-kBLkjUbYFBBwBoUPVa8FW-dg?e=g6IaJM
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool/Example/Models
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool/Example/Models
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool/Example/Metrics
file://///pearl/3d-ltmp/EcoRRAP/outputs/Complexity_Metrics/ComplexityTools/USYD-EcoRRAP_Tool/Example/Metrics
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- Use input paths in the mapped-drive form 
(e.g. Z:\EcoRRAP\…. ) rather than the UNC 
path (\\pearl\3d-ltmp\EcoRRAP\...)   

- Ensure the drive letter entered is the same as mapped 
to your computer  

- If PEARL is not mapped to your computer, follow the 
steps in this link: Map a network drive in Windows - 
Microsoft Support and enter the path '\\pearl\3d-ltmp' 
  

Click ‘Run Script’ 
button  

• Click the large green ‘Run Script’ button in the 
'ComplexityBatBuilder.xlsm' file 

• There will be no change within the excel file, but:  

• New files called 'files.txt' and 'RunMetrics.bat' will be 
generated in the scripts folder   

• Note: You can open the 'files.txt' to see which metric files 
will be written by the script (therefore which models the 
script will be run on) listed as each row of the file   

 

 

Double click the 
'RunMetrics.bat' file to 
run 

• Open the file explorer window and double-click on the 
‘'RunMetrics.bat' file 

• Once clicked: 
- A black Windows console screen will open  
- The console will show script progress (e.g. Loading 

data, Computing metrics, etc.)  
- Once complete, the console window will close 

automatically  
 

Run time is approx. 5-10 minutes per EcoRRAP DSLR 
model (700 - 2,500 MB file size) if run locally (computer 
on-site at AIMS) or through PEARL  

View outputs • Once complete, the following files will be created: 

• Individual models: One folder per model, each with: 
'metrics.csv’ and 'quadrats.ply'   
- Outputs:  

‘metrics.csv’: Whole-plot info (GridX= -1, GridY= -1) and 
per-quadrat info (described by all other GridX and GridY 

Note: To create a .csv file containing the whole plot 
complexity metrics for all models in one file: 

• Use script ‘CombineMetricsOutputs.py’ 

• Open script with a script editor or text viewer and enter 
required inputs and create required filepath .csv file 
(detailed instructions in script) 

file://///pearl/3d-ltmp/EcoRRAP/
https://support.microsoft.com/en-us/windows/map-a-network-drive-in-windows-29ce55d1-34e3-a7e2-4801-131475f9557d
https://support.microsoft.com/en-us/windows/map-a-network-drive-in-windows-29ce55d1-34e3-a7e2-4801-131475f9557d
file://///pearl/3d-ltmp
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values) for each model. 'ComplexityMetrics' outputs 
only (no 'MetricsCals' outputs) 
‘quadrats.ply': Visual model file showing model 
quadrats 

- File location: Folders are named as per model name 
and saved within the folder specified as the output 
location in the ComplexityBatBuilder.xlsm' file. Files for 
each model (.csv and .ply) are saved within the each 
model folder  

 

• ‘Quadrats.ply' files can be viewed in CloudCompare (or 

other 3D model viewer), if viewed in CloudCompare 
- Squares represent quadrat placement used in 

calculations 
- Green squares represent quadrats with calculated 

metrics  
- Red squares represent quadrats that metrics were not 

calculated for (< 75 % of quadrat had model data)  

• Definitions of all complexity metrics are presented in 
Appendix 8, in the AIMS GitHub, and internally in the 
AIMS Tool explainer and Source files folders. Contact 
RFerrari for further discussion re interpretation of these 
metrics r.ferrari@aims.gov.au 

• Run script in your python environment to generate 
summary .csv file 

   

https://github.com/open-AIMS/EcoRRAP
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EiYfCg6xO7tIvLBFX4Zhj-kBLkjUbYFBBwBoUPVa8FW-dg?e=g6IaJM
https://aimsgovau.sharepoint.com/:f:/s/3Dmodelling/EvqtfyQRg-VBrj5XnpjyH3cBdheDINRANEDKc-p2s3RsWg?e=IyO8jU
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Figure 13. 3D Complexity metric export steps: a) ‘ComplexityBatBuilder’ file showing input cells to be 

changed in green with EcoRRAP default settings and large ‘Run Script’ button; b) screenshot of 

‘Run.Metrics’ bat file outputs when running.   

A 

B 
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Figure 14. Example 3D Complexity metric outputs: a) ‘'AllMetrics.csv' output, showing data from multiple 

models for the whole model extent; b) 'metrics.csv' output, showing data from a single model, for the 

whole area and all quadrats; c and d) 'quadrats.ply' outputs, showing data from a single model for the 

whole model extrent with quadrats shown (viewed in CloudCompare at a top down, and slightly oblique 

view, respectively). Note that squares in 'quadrats.ply' outputs represent quadrat placement used in 

calculations with green squares represent quadrats with calculated metrics and red squares indicating 

quadrats that metrics were not calculated for (e.g. < 75 % of quadrat had model data). 
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5 NEXT STEPS AND ADDITIONAL RESOURCES 

5.1 Workflow continued… 

Please see the following SOPs in the current series (Table 1, Figure 1) for next steps in: 

• Annotation and metric extraction (SOP 3) 

5.2 Additional resources/quick links 

• EcoRRAP links 
o Website: EcoRRAP (ecological intelligence for reef restoration)(gbrrestoration.org) 
o SOPs: Reef monitoring sampling methods | AIMS 
o Metadata: EcoRRAP Metadata 
o Data management templates: EcoRRAP Photogrammetry Data Management Templates 
o EcoRRAP Equipment Schematics: EcoRRAP Photogrammetry Equipment Schematics 
o GitHub: GitHub - AIMS/EcoRRAP  
 

• Metashape   
o Download software: https://www.agisoft.com/downloads/installer/  
o Manual/Resources: https://www.agisoft.com/downloads/user-manuals/  
o GitHub: https://github.com/orgs/agisoft-llc/repositories?type=all  

 

• CloudCompare  
o Download software: https://www.cloudcompare.org/main.html  
o Manual/Resources: https://www.cloudcompare.org/main.html  

 

• Python  
o Download software: https://www.python.org/downloads/  
o Manual/Resources: https://www.python.org/doc/ 

 

• Goodsync  
o Download: https://www.goodsync.com/ 
 
 

 

 

 

 

 

https://gbrrestoration.org/program/ecorrap/
https://www.aims.gov.au/research-topics/monitoring-and-discovery/monitoring-great-barrier-reef/reef-monitoring-sampling-methods#SOPreefmonitoring
http://apps.aims.gov.au/metadata/view/fe9659f1-12d6-4acf-ab89-67acdd37efe5
http://apps.aims.gov.au/metadata/view/c353b247-abb1-46cf-bfe2-aa65e727eca5
http://apps.aims.gov.au/metadata/view/e092aaa9-7587-4055-94bb-98440397040a
https://github.com/open-AIMS/EcoRRAP
https://www.agisoft.com/downloads/installer/
https://www.agisoft.com/downloads/user-manuals/
https://github.com/orgs/agisoft-llc/repositories?type=all
https://www.cloudcompare.org/main.html
https://www.cloudcompare.org/main.html
https://www.python.org/doc/
https://www.goodsync.com/
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APPENDICES 

 

Appendix 1. Overview of EcoRRAP 3D model processing workflow. All steps are described in detail in 

Tables 7-12, reproduced from Table 6 in text. 

 

Step Platform Key tasks  

Model 
processing  
(in-field) 

File management 

Microsoft Access 

 

Agisoft 
Metashape 

 

•  Copy image files to computer  

•  Enter metadata and marker depth data into database 

•  Export and save ‘Marker depth’ CSVs from database 

•  Create Metashape project file and import photos 

•  Run processing script: ‘Chain 1’ (Local processing) 

•  Conduct manual QA/QC checks  

Model 
processing 
(in-office) 

Agisoft 
Metashape 
 

•  Save photos and Metashape projects to AIMS network drive 

•  Open Agisoft Network monitor and prepare network 
processing 

•  Reference models (T1) 
- Run Chain 2.1 (Network processing if available) 
- Set reference model orientation (use associated scripts) 
- Run Chain 2.2 (Network processing if available) 

•  Subsequent timepoints (T2, T3…) 
- Run Chain 2 (Network processing if available) 

•  Conduct manual QA/QC check 

•  Export 3D models 

  CloudCompare 
 
 
 

Agisoft 
Metashape 

•  Load ‘reference’ and ‘test’ (non-reference) models  

•  Rename and subsample models 

•  Complete model co-registration and QA/QC 

•  Export transformation matrix 

• Subsequent timepoints (T2, T3…) 
- Load project and run ‘Chain 3’ (Local processing) 

Output 
generation 

Agisoft 
Metashape 
 
ArcGIS 

•  Generate orthomosaic  

•  Export orthomosaic (.tif) as 2D output (final ref. 2D output) 

•  Export 3D model (.ply) as final 3D output (ref. and subs.) 

• Clip orthomosaics from subsequent timepoints (T2, T3…) to 
reference extent in ArcGIS and save final subs. 2D output 
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Appendix 2. Triad coordinate values used in model scaling. Note: ‘Small’ triads are generally used for 

DSLR model scaling, while ‘large’ triads are used for GoPro model scaling. Each EcoRRAP site 

contains 3 x small triads and 1 x large triad. 

Triad type Marker X value Y value Z value 

Large triad Top 0 0 Depth measured 

Left -0.15 -0.204 Depth of top - 0.2 

Right 0.15 -0.204 Depth of top - 0.2 

Small triad Top 0 0 Depth measured 

Left -0.1105 -0.1335 Depth of top - 0.114 

Right 0.1105 -0.1335 Depth of top - 0.114 

 

 

 

Appendix 3. Visual representation of triad coordinate values used in model scaling. 

 

 

 

 

Appendix 4. Marker accuracy values used in model scaling. See descriptions of GCP (ground control 

points) in SOP 1 (Table 1). 

GCP X Accuracy Y Accuracy Z Accuracy  Comment 

Dumbbells 10 10 0.25  

Triad (enabled) 0.005 0.005 0.005 One per GoPro project 

Triad (disabled) 10 10 0.25 GoPro only, all unused GoPro triads  
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Appendix 5. List of all current Metashape processing scripts  

Chain Script type Camera Reference model 
(Y/N/All) 

Processing location Script name Dependencies 

1 
 

Chain DSLR 
 

All 
 

Local Chain1_Local_DSLR.py  
Chain Network Chain1_Network_DSLR.py DisableLowQPhotos_DSLR.py 

MarkerQCheck_DSLR.py 
ScalebarAddQCheck_DSLR.py 

Script Local/Network DisableLowQPhotos_DSLR.py  
Script Local/Network MarkerQCheck_DSLR.py  
Script Local/Network ScalebarAddQCheck_DSLR.py  

 
 

Chain GoPro 
 

All Local Chain1_Local_GoPro.py  
Chain  Network Chain1_Network_GoPro.py DisableLowQPhotos_GoPro.py 

MarkerQCheck_GoPro.py 
ScalebarAddQCheck_GoPro.py 

Script  Local/Network DisableLowQPhotos_GoPro.py  
Script  Local/Network MarkerQCheck_GoPro.py  
Script  Local/Network ScalebarAddQCheck_GoPro.py  

 
 

2 
 

Chain DSLR 
 

N Network Chain2_Network_DSLR_NonRef.py SparseCloudClean_DSLR.py 
Chain Y Network Chain2.1_Network_DSLR_Ref.py SparseCloudClean_DSLR.py 

ResizeRegion.py 
Chain Y Network Chain2.2_Network_DSLR_Ref.py  

Script All Local/Network SparseCloudClean_DSLR.py  

Script Y Local/Network ResizeRegion.py 
 

 

Chain GoPro N Network Chain2_Network_GoPro.py SparseCloudClean_GoPro.py 
 Script  All Local/Network SparseCloudClean_GoPro.py 

 
 

3 Chain DSLR N Local Chain3_Local_DSLR_NonRef.py  
 

 Chain GoPro N Local Chain3_Local_GoPro_NonRef.py  
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Appendix 5. EcoRRAP model processing troubleshooting steps.  

Step Issue  Solution  Additional info 

Any network 
processing 

Network 
processing fails 
due to error 
locating image  

• Within Metashape, right-click any photo and select ‘Check paths’ >  ‘Entire workspace’  

• If any photos are missing or file paths are broken they will be displayed in the dialogue box 

• To correct the file path, right-click any photo and select ‘Change path’ > ‘Entire workspace’ and 
navigate to the correct location and select a file within it 

• Run ‘Check paths’ > ‘Entire workspace’ again to check if issue has been resolved  

• Note: If changing paths of renamed files (e.g. GoPro files bulked renamed in the form ‘GP1 
(1).JPG), ensure the file extension ‘JPEG’ is correct when selecting the file in its’ folder location 
 

 

Image quality 
assessment 

Not all images 
assessed 
 
 
Images below 
threshold 
enabled 

• If images are missing quality value (values missing in Photos pane > Details view) select images 

with missing values, right-click and select ‘Estimate image quality’ > Selected cameras 

• Images will then be assessed for quality (job can run locally or on the network as required) 

 

• To manually disable cameras navigate to Photo pane > Details view > Sort by quality (click 

column heading) > The select (click + shift) photos to be disabled, right click and select ‘Disable 

cameras’ 
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Alignment  
 
 
 
 
 
 
 
 
 
 
 
 
Alignment 
cont.  

Low alignment 
(< 80 %)  
 
 
 
 
 
 
 
 
 
 
 
Low alignment 
(< 80 %) cont.  

• Check and address any errors relating to file management and photo quality: 
- Errors in imported photos (time, date, and camera incorrect) 
- Missing files (number and timestamp of photos incorrect) 

- Poor photo quality (photos out of focus, incorrect camera settings, turbid water 

• If the above does not improve alignment, check for errors relating to model alignment: 

- Model shape does not reflect realistic reef shape and structure 

- Model has multiple axes (multiple colliding planes) 

- Model has large spread of floating points and no clear structure 

- If there is no issue with files, the above errors generally indicate an issue with dubious 

marker detection causing errors in model alignment (proceed to next step) 

• Check markers for numbers of projections and projection error 

- Disable and uncheck questionable markers (low projections, high error) and realign model 

- If this is unsuccessful, remove all markers, realign, then re-detect markers after alignment 

• If all above steps do not work, realign model with the following settings: 

- Quality: High 

- Generic preselection: No (uncheck) 

- Keypoint limit = 0  

- Tiepoint limit = 0 

- Note that processing time will these settings may increase significantly  

3. For ma  

Bayley and Mogg 
(2020) 
  
Keypoint/ tiepoint 
limits: 
https://www.agisoft.c
om/forum/index.php
?topic=3559.0  
 
https://www.youtube
.com/watch?v=AWso
2m2FPkA  
  

Marker 
detection 
 
 
 
 
 
  

Low marker 
detection 

• Add markers manually 

• If one marker of a ground control point (GPC) is not detected but another is, right-clicking on 
an existing detected marker and select ‘Filter photos by markers’ 

• Select photos in which the undetected marker is visible and drop a marker on its’ centre by 
right-clicking the centre of the unrecognised marker and selecting ‘Add Marker’ 

• A new marker will now be visible in the Reference pane as ‘point 1’ 

• Rename the marker from ‘point 1’ to the appropriate Target number as displayed on the GPC 
and edit coordinate values and error as appropriate 

• Add an additional projection by double-clicking on another photo with the missing marker 
visible and right clicking on the centre of the marker and selecting ‘Place marker’ and selecting 
the marker required 

 
Over et al. 2021 

https://www.agisoft.com/forum/index.php?topic=3559.0
https://www.agisoft.com/forum/index.php?topic=3559.0
https://www.agisoft.com/forum/index.php?topic=3559.0
https://www.youtube.com/watch?v=AWso2m2FPkA
https://www.youtube.com/watch?v=AWso2m2FPkA
https://www.youtube.com/watch?v=AWso2m2FPkA
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• Once two projections of the new marker have been made, right click the marker in the 
Reference pane and select ‘Filter photos by markers’ 

• Add projections on the resultant photos by clicking on or moving the automatically detected 
white flags to confirm them (confirmed projections will be shown in green) 

• Repeat until all targets have at least 5-10 projections (DSLR and GoPro, respectively) 

• If marker pairs can’t be used to add missing markers, click on the ‘Show images’  button on the 
toolbar to overlay the point cloud with photos from the region in focus 

• Navigate around the point cloud and look for images with undetected markers 

• Once found, right click on the marker and select ‘Filter photos by point’ 

• New markers and projections can now be added to these images as per above steps 
  

Marker 
detection  

Low marker 
projections 
 

• Follow above steps (excluding addition of new markers) to add more projections to markers  

 High marker 
projection 
error  
 

• If there are sufficient other markers to complete scaling, disable marker and do not use 

• If there are not sufficient other markers to complete scaling, check projections  

• Within the reference pane, right-click the marker in question and select ‘Show info’ 

• Click on the ‘Value’ column heading and arrange in descending order of pixel error  

• Double-click the image containing the highest error value to display it 

• Check if the marker projection looks incorrect or not (i.e. placed on coral, placed at distorted 
edge of image) 

• If projection is questionable, remove the projection by right-clicking the marker and select 
‘Remove marker’ 

• This should lower the error value. If still greater than 10 pixels, repeat these steps for the next 
image with the highest associated target error value. 

• These steps can also be used as troubleshooting if scaling error is high 
 

 

Scalebar  
error too  
high 

Control scale 
bar value: 
> 0.01 (DSLR) 
> 0.02 (GoPro) 

• Ensure that only the markers of one triad (if more than one used in chunk) are checked in the 
marker pane 

• Uncheck all dumbbell markers and click ‘Update transform’ at the top of the reference pane 
and check the effects on the control scale bars value 
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• If this drops the value < 0.01, check one dumbbell marker at a time, clicking update transform 
after each change. Continue checking and un-checking dumbbells and updating the transform 
until you check as many dumbbell markers as possible while keeping the control scale bars 
value < 0.01/0.02 

• Scalebars of dumbbell markers unchecked in the marker pane do not need to be unchecked or 
removed in the scalebar pane 
 

Co-
registration 

Co-registration 
error too high 

• Click ‘Adjust scale’ check box in co-registration pane and see if error decreases 

• If so, open Metashape projects and check Reference pane for scaling error 

• Complete above scale bar error and marker projection error troubleshooting steps to improve 
model scaling error  

• Export adjusted models and repeat co-registration procedure 
 

• If clicking the ‘Adjust scale’ check box does not improve co-registration error, visually check 
whether sphere trees have moved (e.g. not in same position in both models) 

• If sphere trees have moved, delete spheres placed on moved trees and do not use for co-
registration 

• Instead, de-select the sphere tool and use the point tool to select additional benthic points on 
the reef for co-registration points   

 

 
Orthomosaic 
cropping  

 
Orthomosaics 
do not line up 

 

• Check imported orthomosaics are correct (correct file name and version), if they are complete 
the following checks: 
 

• Open Metashape projects of orthomosaics and check that coordinates of orthomosaics and 3D 
models are consistent  

• Check coordinates by using the ‘Ruler’ tool to click on a feature on both the orthomosaic and 
model 

• Navigate to the Console pane and check whether the coordinates of both the model and 
orthomosaic are consistent (indicates that issue is not due to orthomosaic generation) 
 

• If coordinates are consistent, check whether models have been correctly co-registered 

• Open Metashape projects and export models 
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• Import models into CloudCompare and examine whether they are lined up 

• If not, re-coregister models and apply the transformation matrix in Metashape (as per Tables 
11,12). 

  



   
 

   
 

 
 
Appendix 6. Steps to decimate 3D models prior and upload to Sketchfab. 
 
 Metashape steps 
 

1. Open desired Metashape project  
2. Once project is opened, select (double-click) the chunk containing the model to decimate 
3. Run script by pressing Ctrl-R and navigate to the script location 

• E.g. \\pearl\3d-ltmp\scripts\EcoRRAP\PythonScripts\ 
4. Select the Python script required based on the number of chunks requiring decimation: 

•  Single chunk: ‘SketchFab_Prep.py’ 

• Multiple chunks:  ‘SketchFab_ModelPrepMultipleChunks.py’ 

• Select ‘no’ to network processing when prompted 
5. Decimating will take approx. 5-10 minutes per model 
6. Once models are decimated, run script (as above) ‘SketchFab_ModelUpload.py’  

• Note: This will upload only your active chunk, so ensure your decimated chunk is set 
as active before running script 

7. Check Metashape console to ensure no error messages occur then close Metashape 
8. Note: Do not run multiple project scripts simultaneously, scripts use the same temporary file 

 

SketchFab steps  
 

1. Models uploaded via above steps may take up to ten minutes to appear in SketchFab 
2. When model is uploaded it will be visible as a blank, featureless thumbnail with the same 

name as the file name originally used (e.g., ‘OCDA_FR1S_P1_202301.psx’)  
3. Navigate to the three dots near the bottom right of the model icon > Select properties   
4. Change the title of the project by: 

• Deleting the file extension, e.g. ‘OCDA_FR1S_P1_202301.psx’ 

• Changing the reef code to reef name, e.g. ‘Davies_FR1S_P1_202301’ 
5. After the title is changed, select the ‘Allow AR?’ toggle on the right side of the page. This 

allows certain devices to view our models in Augmented Reality.  
6. Select 'Free' under the Download tab on the right side of the page. Ensure that the License 

that appears says CC Attribution to allows for use and distribution of models with fair 
attribution.  

7. Click ‘Save’ on the bottom right 
8. Once properties are saved, click on the blue ‘Edit 3D Settings’ button near the top 
9. Navigate to the first tab > General > select ‘Show advanced rotation’ toggle and rotate your 

model to be upright. Most models will start upside down. 

• Note: Use plate corals and the sphere trees to orient the model upright. Start by 
hitting the arrow next to X under the rotate tab twice to flip it over and work from 
there.  

10. Rotate the camera using the mouse (click and drag) to a top-down position so you can view 
the entire model. It should look the same as the other thumbnails in Sketchfab. Once you 
have a suitable view and zoom level, click ‘Save View’ in the top left corner of the model 
viewer.  

11. Navigate to the AR/VR tab in the navigation ribbon > ‘World Scale’ > click the ‘Use 1 Unit = 1 
Meter’ button to set the scale for VR. You may want to use the arrows under the human 
figure to drag the starting view closer to the model—typically one or two grid squares away.  

12. Click ‘Save Settings’ in the top right corner. 
 

file://///pearl/3d-ltmp/scripts/EcoRRAP/PythonScripts/


   
 

   
 

 
 
Appendix 7. Steps to colour-correct GoPro orthomosaics. 
 

Photoshop steps 

1. Import orthomosaic (.TIFF) to Photoshop 

2. Select the ‘Levels’ tool in the ‘Adjustment’ tab (Fig. 1a) 

3. Select the ‘Eyedropper’ tool (black, grey or white) in the ‘Colours’ tab, then select your 

sample size (Fig. 1b) 

4. Using the ‘Eyedropper’ tool, click on the desired points in the orthomosaic used to colour 

correct the image (ideally these should be the black or white of dumbbells or colour charts 

placed in the plots (Fig. 1b) 

5. Note: selecting points at different depths will improve the overall result. 

6. You may save your edit settings to apply to other projects by adding the selected layers to 

‘Your presents (+)’ adjustments (Fig. 1a) 

7. Export the colour-corrected file to a final location in the format required (generally .TIFF) 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure A1. Screenshot of Photoshop showing: a) ‘Levels’ and ‘Presets’ tools, and; b) ‘Eyedropper’ 
tool.  

 
 



   
 

   
 

 
Appendix 8. Complexity metrics definitions from Mitch Bryson ('ComplexityMetrics' tool) and Ryan 
Krensel ('MetricsCalc' tool). 
 

complexitymetrics tool     

Values below are summarised in 'metrics.csv' file for 
each mesh. Each row is a sample unit (whole mesh is 
first row, quadrats come after this).  

   

Descriptor  Explanation  

Mesh  Name of the mesh  

Grid X  Quadrat position in grid - x dimension. -1 for 
full mesh  

Grid Y  Quadrat position in grid - y dimension. -1 for 
full mesh  

Center X  x value (in model coordinate system) of 
sample unit.  

Center Y  y value (in model coordinate system) of 
sample unit.  

Center Z  z value (in model coordinate system) of 
sample unit.  

Quad Size  length of one side of square quadrat (as 
defined by user)  

Num Faces  Number of faces found in the sample unit.  

Num Verts  Number of vertices found in the sample unit.  

Landscape Slope  Slope (0 is flat) of the overall mesh (will be 
the same for all sample units)  

Quad Fitted Slope  slope (0 is flat) of the mesh in just the area of 
the sample  unit.  

Vertical Angle Mean  Mean value of all face angles (0 is flat) in the 
sample unit.  

Vertical Angle StdDev  Standard deviation of all face angels ((0 is 
flat) in the sample unit.  

VertAngHist xx-xxdeg  Percent of all face angles in the sample unit 
within the designated degree bin. 0 is flat, 90 
is vertical, 180 is downward facing.  

Quad Height Range  Range (max-min) of heights (z-values) of all 
faces in a sampling unit.  

Quad Height StdDev  Standard deviation (max-min) of heights (z-
values) of all faces in a sampling unit.  

Quad 2D Area  The 2D area of the sample unit projected 
onto the overall model plane.  

Quad 3D Area  The 3D area of the sample unit (sum of all 
faces within the unit).  



   
 

   
 

Quad Rugosity  3D area divided by 2D area  

Quad 2D Area (plane)  The 2D area of the sample unit projected 
onto the plane of best fit of all data within 
the sample unit.  

Quad Rugosity (plane)  3D area divided by 2D area (plane)  

Quad Height Range (x.xx m)  As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad Height StdDev (x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad 2D Area (x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad 3D Area (x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad Rugosity (x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad 2D Area (plane) (x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  

Quad Rugosity (plane)(x.xx m)   As above but for model built with stated 
resolution (xx.x m).  Present for all 
resolutions listed in the resolutions.txt file.  
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